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  preface


  This is the 49th book I have written. I wrote my first book in 1996, and I would not have believed anyone who told me that I would still be writing over a quarter of a century later, or that books would become such an important part of my life.


  I have a bookshelf on which I keep every book I have written. It is an act of pure self-indulgence, but I am proud of these books and what they represent. They span 2.5 meters on a single shelf (or 8 feet if you prefer) and they mark the chapters of my life: the book I wrote the year I married my beloved wife; the book I was writing when my father died; the book I finished while we moved house; the book I wrote after I retired. Each book reminds me of people and places going back 27 years.


  Of all the books I have written, Pro ASP.NET Core is my favourite. This is the 10th edition, but I almost didn’t write it at all. I had already written a book about ASP.NET Web Forms and found it to be a frustrating process, so I wasn’t keen to write about the MVC framework and Microsoft’s attempt to modernize their web development products. My wife persuaded me to accept the publisher’s offer and I have never looked back. ASP.NET has evolved into ASP.NET Core, and each edition of this book has been a little bigger and a little more detailed.


  This is a big and complicated book because ASP.NET Core is big and complicated. But I put a lot of effort into writing books that are easy to follow, even if the topics can be difficult to understand. As I write this preface and I think of you, my future reader, my hope is that the book you hold in your hand helps you with your career, makes your project easier to implement, or helps you move into a new and more exciting role.


  There is something unique about receiving the first copies of a book, fresh from the printers. The process of getting a book into print takes just enough time for it to be a surprise when the box arrives at the door. Writing is an abstract process and writing about software especially so. The finished book feels like an idea made real. These days, ebooks are more popular and more convenient, but my heart will always beat with joy for the printed version. As you hold this book, I hope you feel some of that joy, and that this book plays some small part in helping you achieve something you will be proud of, whatever that may be.


  about this book


  Pro ASP.NET Core, Tenth Edition was written to help you build web applications using the latest version of .NET and ASP.NET Core. It begins with setting up the development environment and creating a simple web application, before moving on to creating a simple but realistic online store, and then diving into the detail of important ASP.NET Core features.


  Who should read this book


  This book is for experienced developers who are new to ASP.NET Core, or who are moving from an earlier version of ASP.NET, including legacy Web Forms.


  How this book is organized: a roadmap


  The book has four parts. The first part covers setting up the development environment, creating a simple web application, and using the development tools. There is also a primer on important C# features for readers who are moving from an earlier version of ASP.NET or ASP.NET Core. The rest of this part of the book contains the SportsStore example application, which shows how to create a basic but functional online store, and demonstrates how the many different ASP.NET Core features work together.


  The second part of the book describes the key features of the ASP.NET Core platform. I explain how HTTP requests are processed, how to create and use middleware components, how to create routes, how to define and consume services, and how to work with Entity Framework Core. These chapters explain the foundations of ASP.NET Core, and understanding them is essential for effective ASP.NET Core development.


  The third part of the book focuses on the ASP.NET features you will need every day, including HTTP request handling, creating RESTful web services, generating HTML responses, and receiving data from users.


  The final part of this book describes advanced ASP.NET Core features, including using Blazor to create rich client-side applications, and using ASP.NET Core Identity to authenticate users.


  About the code


  This book contains many examples of source code both in numbered listings and in line with normal text. In both cases, the source code is formatted in a fixed-width font to separate it from ordinary text. Code is also in bold to highlight statements that have changed from previous listings.


  The source code for every chapter in this book is available at https://github.com/manningbooks/pro-asp.net-core-7.


  liveBook discussion forum


  Purchase of Pro ASP.NET Core 7, Tenth Edition includes free access to liveBook, Manning’s online reading platform. Using liveBook’s exclusive discussion features, you can attach comments to the book globally or to specific sections or paragraphs. It’s a snap to make notes for yourself, ask and answer technical questions, and receive help from the author and other users. To access the forum, go to https://livebook.manning.com/book/pro-aspdotnet-core-7-tenth-edition/discussion. You can also learn more about Manning’s forums and the rules of conduct at https://livebook.manning.com/discussion.


  Manning’s commitment to our readers is to provide a venue where a meaningful dialogue between individual readers and between readers and the author can take place. It is not a commitment to any specific amount of participation on the part of the author, whose contribution to the forum remains voluntary (and unpaid). We suggest you try asking the author some challenging questions lest his interest stray! The forum and the archives of previous discussions will be accessible from the publisher’s website as long as the book is in print.


  about the author
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  Adam Freeman is an experienced IT professional who started his career as a programmer. He has held senior positions in a range of companies, most recently serving as Chief Technology Officer and Chief Operating Officer of a global bank. He has written 49 programming books, focusing mostly on web application development. Now retired, he spends his time writing and trying to make furniture.


  About the technical editor


  Fabio Claudio Ferracchiati is a senior consultant and a senior analyst/developer using Microsoft technologies. He works for TIM (www.telecomitalia.it). He is a Microsoft Certified Solution Developer for .NET, a Microsoft Certified Application Developer for .NET, a Microsoft Certified Professional, and a prolific author and technical reviewer. Over the past ten years, he’s written articles for Italian and international magazines and coauthored more than ten books on a variety of computer topics.


  about the cover illustration


  The figure on the cover of Pro ASP.NET Core 7, Tenth Edition is “Turc en habit d’hiver,” or “Turk in winter clothes,” taken from a collection by Jacques Grasset de Saint-Sauveur, published in 1788. Each illustration is finely drawn and colored by hand.


  In those days, it was easy to identify where people lived and what their trade or station in life was just by their dress. Manning celebrates the inventiveness and initiative of the computer business with book covers based on the rich diversity of regional culture centuries ago, brought back to life by pictures from collections such as this one.


  1 Putting ASP.NET Core in context


  This chapter covers


  
    	Putting ASP.NET Core in context


    	Understanding the role of the ASP.NET Core platform


    	Putting the ASP.NET Core application frame works in context


    	Understanding the structure of this book


    	Getting support when something doesn’t work

  


  ASP.NET Core is Microsoft’s web development platform. The original ASP.NET was introduced in 2002, and it has been through several reinventions and reincarnations to become ASP.NET Core 7, which is the topic of this book.


  ASP.NET Core consists of a platform for processing HTTP requests, a series of principal frameworks for creating applications, and secondary utility frameworks that provide supporting features, as illustrated by figure 1.1.
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    Figure 1.1 The structure of ASP.NET Core

  


  
    Understanding .NET Core, .NET Framework, and .NET


    If you have never worked for a large corporation, you might have the impression that Microsoft is a disciplined organization with a clear strategy and an army of programmers working together to deliver complex products like ASP.NET Core.


    In reality, Microsoft is a chaotic collection of dysfunctional tribes that are constantly trying to undermine each other to get prestige and promotions. Products are released during lulls in the fighting, and successes are often entirely unexpected. This isn’t unique to Microsoft—it is true of any large company—but it has a particular bearing on ASP.NET Core and the naming confusion that Microsoft has created.


    Several years ago, the part of Microsoft responsible for ASP.NET created its own version of the .NET platform, allowing ASP.NET to be updated more often than the rest of .NET. ASP.NET Core and .NET Core were created, allowing cross-platform development, and using a subset of the original .NET APIs, many of which were specific to Windows. It was a painful transition, but it meant that web development could evolve independently of the “legacy” Windows-only development, which would continue under the renamed .NET Framework.


    But no one wants to be in the “legacy” tribe because there is no glory in keeping the lights on at Microsoft. .NET Core was clearly the future and, one by one, the.NET groups at Microsoft argued that their technology and APIs should be part of .NET Core. The .NET Core APIs were gradually expanded, and the result was an incoherent mess, with half-hearted attempts to differentiate .NET Core and .NET Framework and standardize the APIs.


    To clean up the mess, Microsoft has merged .NET Core and .NET Framework into .NET, dropping the Core part of the name. “.NET” is a name I like to think was chosen on the way out of the office on a holiday weekend but which I suspect is the result of many months of heated argument.


    The problem with dropping Core from the name is that it cannot be carried out consistently. The name ASP.NET Core originally denoted the .NET Core version of ASP.NET, and going back to that name would be even more confusing.


    The result is that even Microsoft can’t decide what name to use. You will see the term ASP.NET Core in a lot of the developer documentation—and that’s the name I use in this book—but you will also see ASP.NET Core in .NET, especially in press releases and marketing material. It is not clear which name will win out, but until there is clarity, you should take care to determine whether you are using .NET Framework, .NET Core, or .NET.

  


  1.1 Understanding the application frameworks


  When you start using ASP.NET Core, it can be confusing to find that there are different application frameworks available. As you will learn, these frameworks are complementary and solve different problems, or, for some features, solve the same problems in different ways. Understanding the relationship between these frameworks means understanding the changing design patterns that Microsoft has supported, as I explain in the sections that follow.


  1.1.1 Understanding the MVC Framework


  The MVC Framework was introduced in the early ASP.NET, long before .NET Core and the newer .NET were introduced. The original ASP.NET relied on a development model called Web Forms, which re-created the experience of writing desktop applications but resulted in unwieldy web projects that did not scale well. The MVC Framework was introduced alongside Web Forms with a development model that embraced the character of HTTP and HTML, rather than trying to hide it.


  MVC stands for Model-View-Controller, which is a design pattern that describes the shape of an application. The MVC pattern emphasizes separation of concerns, where areas of functionality are defined independently, which was an effective antidote to the indistinct architectures that Web Forms led to.


  Early versions of the MVC Framework were built on the ASP.NET foundations that were originally designed for Web Forms, which led to some awkward features and workarounds. With the move to .NET Core, ASP.NET became ASP.NET Core, and the MVC Framework was rebuilt on an open, extensible, and cross-platform foundation.


  The MVC Framework remains an important part of ASP.NET Core, but the way it is commonly used has changed with the rise of single-page applications (SPAs). In an SPA, the browser makes a single HTTP request and receives an HTML document that delivers a rich client, typically written in a JavaScript framework such as Angular or React. The shift to SPAs means that the clean separation that the MVC Framework was originally intended for is not as important, and the emphasis placed on following the MVC pattern is no longer essential, even though the MVC Framework remains useful (and is used to support SPAs through web services, as described in chapter 19).


  
    Putting patterns in their place


    Design patterns provoke strong reactions, as the emails I receive from readers will testify. A substantial proportion of the messages I receive are complaints that I have not applied a pattern correctly.


    Patterns are just other people’s solutions to the problems they encountered in other projects. If you find yourself facing the same problem, understanding how it has been solved before can be helpful. But that doesn’t mean you have to follow the pattern exactly, or at all, as long as you understand the consequences. If a pattern is intended to make projects manageable, for example, and you choose to deviate from that pattern, then you must accept that your project may be more difficult to manage. But a pattern followed slavishly can be worse than no pattern at all, and no pattern is suited to every project.


    My advice is to use patterns freely, adapt them as necessary, and ignore zealots who confuse patterns with commandments.

  


  1.1.2 Understanding Razor Pages


  One drawback of the MVC Framework is that it can require a lot of preparatory work before an application can start producing content. Despite its structural problems, one advantage of Web Forms was that simple applications could be created in a couple of hours.


  Razor Pages takes the development ethos of Web Forms and implements it using the platform features originally developed for the MVC Framework. Code and content are mixed to form self-contained pages; this re-creates the speed of Web Forms development without some of the underlying technical problems (although scaling up complex projects can still be an issue).


  Razor Pages can be used alongside the MVC Framework, which is how I tend to use them. I write the main parts of the application using the MVC Framework and use Razor Pages for the secondary features, such as administration and reporting tools. You can see this approach in chapters 7–11, where I develop a realistic ASP.NET Core application called SportsStore.


  1.1.3 Understanding Blazor


  The rise of JavaScript client-side frameworks can be a barrier for C# developers, who must learn a different—and somewhat idiosyncratic—programming language. I have come to love JavaScript, which is as fluid and expressive as C#. But it takes time and commitment to become proficient in a new programming language, especially one that has fundamental differences from C#.


  Blazor attempts to bridge this gap by allowing C# to be used to write client-side applications. There are two versions of Blazor: Blazor Server and Blazor WebAssembly. Blazor Server relies on a persistent HTTP connection to the ASP.NET Core server, where the application’s C# code is executed. Blazor WebAssembly goes one step further and executes the application’s C# code in the browser. Neither version of Blazor is suited for all situations, as I explain in chapter 33, but they both give a sense of direction for the future of ASP.NET Core development.


  1.1.4 Understanding the utility frameworks


  Two frameworks are closely associated with ASP.NET Core but are not used directly to generate HTML content or data. Entity Framework Core is Microsoft’s object-relational mapping (ORM) framework, which represents data stored in a relational database as .NET objects. Entity Framework Core can be used in any .NET application, and it is commonly used to access databases in ASP.NET Core applications.


  ASP.NET Core Identity is Microsoft’s authentication and authorization framework, and it is used to validate user credentials in ASP.NET Core applications and restrict access to application features.


  I describe only the basic features of both frameworks in this book, focusing on the capabilities required by most ASP.NET Core applications. But these are both complex frameworks that are too large to describe in detail in what is already a large book about ASP.NET Core.


  
    Topics for future editions


    I don’t have space in this book to cover every ASP.NET Core, Entity Framework Core, and ASP.NET Core Identity feature, so I have focused on those aspects that most projects require. If there are topics you think I should include in the next edition or in new deep-dive books, then please send me your suggestions at adam@adam-freeman.com.

  


  1.1.5 Understanding the ASP.NET Core platform


  The ASP.NET Core platform contains the low-level features required to receive and process HTTP requests and create responses. There is an integrated HTTP server, a system of middleware components to handle requests, and core features that the application frameworks depend on, such as URL routing and the Razor view engine.


  Most of your development time will be spent with the application frameworks, but effective ASP.NET Core use requires an understanding of the powerful capabilities that the platform provides, without which the higher-level frameworks could not function. I demonstrate how the ASP.NET Core platform works in detail in part 2 of this book and explain how the features it provides underpin every aspect of ASP.NET Core development.


  I have not described two notable platform features in this book: SignalR and gRPC. SignalR is used to create low-latency communication channels between applications. It provides the foundation for the Blazor Server framework that I describe in part 4 of this book, but SignalR is rarely used directly, and there are better alternatives for those few projects that need low-latency messaging, such as Azure Event Grid or Azure Service Bus.


  gRPC is an emerging standard for cross-platform remote procedure calls (RPCs) over HTTP that was originally created by Google (the g in gRPC) and offers efficiency and scalability benefits. gRPC may be the future standard for web services, but it cannot be used in web applications because it requires low-level control of the HTTP messages that it sends, which browsers do not allow. (There is a browser library that allows gRPC to be used via a proxy server, but that undermines the benefits of using gRPC.) Until gRPC can be used in the browser, its inclusion in ASP.NET Core is of interest only for projects that use it for communication between back-end servers, such as in microservices development. I may cover gRPC in future editions of this book but not until it can be used in the browser.


  1.2 Understanding this book


  To get the most from this book, you should be familiar with the basics of web development, understand how HTML and CSS work, and have a working knowledge of C#. Don’t worry if you haven’t done any client-side development, such as JavaScript. The emphasis in this book is on C# and ASP.NET Core, and you will be able to pick up everything you need to know as you progress through the chapters. In chapter 5, I summarize the most important C# features for ASP.NET Core development.


  1.2.1 What software do I need to follow the examples?


  You need a code editor (either Visual Studio or Visual Studio Code), the .NET Core Software Development Kit, and SQL Server LocalDB. All are available for use from Microsoft without charge, and chapter 2 contains instructions for installing everything you need.


  1.2.2 What platform do I need to follow the examples?


  This book is written for Windows. I used Windows 10 Pro, but any version of Windows supported by Visual Studio, Visual Studio Code, and .NET Core should work. ASP.NET Core is supported on other platforms, but the examples in this book rely on the SQL Server LocalDB feature, which is specific to Windows. You can contact me at adam@adam-freeman.com if you are trying to use another platform, and I will give you some general pointers for adapting the examples, albeit with the caveat that I won’t be able to provide detailed help if you get stuck.


  1.2.3 What if I have problems following the examples?


  The first thing to do is to go back to the start of the chapter and begin again. Most problems are caused by missing a step or not fully following a listing. Pay close attention to the emphasis in code listings, which highlights the changes that are required.


  Next, check the errata/corrections list, which is included in the book’s GitHub repository. Technical books are complex, and mistakes are inevitable, despite my best efforts and those of my editors. Check the errata list for the list of known errors and instructions to resolve them.


  If you still have problems, then download the project for the chapter you are reading from the book’s GitHub repository, https://github.com/manningbooks/pro-asp.net-core-7, and compare it to your project. I create the code for the GitHub repository by working through each chapter, so you should have the same files with the same contents in your project.


  If you still can’t get the examples working, then you can contact me at adam@adam-freeman.com for help. Please make it clear in your email which book you are reading and which chapter/example is causing the problem. Please remember that I get a lot of emails and that I may not respond immediately.


  1.2.4 What if I find an error in the book?


  You can report errors to me by email at adam@adam-freeman.com, although I ask that you first check the errata/corrections list for this book, which you can find in the book’s GitHub repository at https://github.com/manningbooks/pro-asp.net-core-7, in case it has already been reported.


  I add errors that are likely to cause confusion to readers, especially problems with example code, to the errata/corrections file on the GitHub repository, with a grateful acknowledgment to the first reader who reported them. I also publish a typos list, which contains less serious issues, which usually means errors in the text surrounding examples that are unlikely to prevent a reader from following or understanding the examples.


  
    Errata bounty


    Manning has agreed to give a free ebook to readers who are the first to report errors that make it onto the GitHub errata list for this book, which is for serious issues that will disrupt a reader’s progress. Readers can select any Manning ebook, not just my books.


    This is an entirely discretionary and experimental program. Discretionary means that only I decide which errors are listed in the errata and which reader is the first to make a report. Experimental means Manning may decide not to give away any more books at any time for any reason. There are no appeals, and this is not a promise or a contract or any kind of formal offer or competition. Or, put another way, this is a nice and informal way to say thank you and to encourage readers to report mistakes that I have missed when writing this book.

  


  1.2.5 What does this book cover?


  I have tried to cover the features that will be required by most ASP.NET Core projects. This book is split into four parts, each of which covers a set of related topics.


  Part 1: Introducing ASP.NET Core


  This part of the book introduces ASP.NET Core. In addition to setting up your development environment and creating your first application, you’ll learn about the most important C# features for ASP.NET Core development and how to use the ASP.NET Core development tools. Most of part 1 is given over to the development of a project called SportsStore, through which I show you a realistic development process from inception to deployment, touching on all the main features of ASP.NET Core and showing how they fit together—something that can be lost in the deep-dive chapters in the rest of the book.


  Part 2: The ASP.NET Core platform


  The chapters in this part of the book describe the key features of the ASP.NET Core platform. I explain how HTTP requests are processed, how to create and use middleware components, how to create routes, how to define and consume services, and how to work with Entity Framework Core. These chapters explain the foundations of ASP.NET Core, and understanding them is essential for effective ASP.NET Core development.


  Part 3: ASP.NET Core applications


  The chapters in this part of the book explain how to create different types of applications, including RESTful web services and HTML applications using controllers and Razor Pages. These chapters also describe the features that make it easy to generate HTML, including the views, view components, and tag helpers.


  Part 4: Advanced ASP.NET Core features


  The final part of the book explains how to create applications using Blazor Server, how to use the experimental Blazor WebAssembly, and how to authenticate users and authorize access using ASP.NET Core Identity.


  1.2.6 What doesn’t this book cover?


  This book doesn’t cover basic web development topics, such as HTML and CSS, and doesn’t teach basic C# (although chapter 5 does describe C# features useful for ASP.NET Core development that may not be familiar to developers using older versions of .NET).


  As much as I like to dive into the details in my books, not every ASP.NET Core feature is useful in mainstream development, and I have to keep my books to a printable size. When I decide to omit a feature, it is because I don’t think it is important or because the same outcome can be achieved using a technique that I do cover.


  As noted earlier, I have not described the ASP.NET Core support for SignalR and gRPC, and I note other features in later chapters that I don’t describe, either because they are not broadly applicable or because there are better alternatives available. In each case, I explain why I have omitted a description and provide a reference to the Microsoft documentation for that topic.


  1.2.7 How do I contact the author?


  You can email me at adam@adam-freeman.com. It has been a few years since I first published an email address in my books. I wasn’t entirely sure that it was a good idea, but I am glad that I did it. I have received emails from around the world, from readers working or studying in every industry, and—for the most part anyway—the emails are positive, polite, and a pleasure to receive.


  I try to reply promptly, but I get a lot of email, and sometimes I get a backlog, especially when I have my head down trying to finish writing a book. I always try to help readers who are stuck with an example in the book, although I ask that you follow the steps described earlier in this chapter before contacting me.


  While I welcome reader emails, there are some common questions for which the answers will always be no. I am afraid that I won’t write the code for your new startup, help you with your college assignment, get involved in your development team’s design dispute, or teach you how to program.


  1.2.8 What if I really enjoyed this book?


  Please email me at adam@adam-freeman.com and let me know. It is always a delight to hear from a happy reader, and I appreciate the time it takes to send those emails. Writing these books can be difficult, and those emails provide essential motivation to persist at an activity that can sometimes feel impossible.


  1.2.9 What if this book has made me angry and I want to complain?


  You can still email me at adam@adam-freeman.com, and I will still try to help you. Bear in mind that I can only help if you explain what the problem is and what you would like me to do about it. You should understand that sometimes the only outcome is to accept I am not the writer for you and that we will have closure only when you return this book and select another. I’ll give careful thought to whatever has upset you, but after 25 years of writing books, I have come to understand that not everyone enjoys reading the books I like to write.


  Summary


  
    	
      ASP.NET Core is a cross-platform framework for creating web applications.

    


    	
      The ASP.NET Core platform is a powerful foundation on which application frameworks have been built.

    


    	
      The MVC Framework was the original ASP.NET Core framework. It is powerful and flexible but takes time to prepare.

    


    	
      The Razor Pages framework is a newer addition, which requires less initial preparation but can be more difficult to manage in complex projects.

    


    	
      Blazor is a framework that allows client-side applications to be written in C#, rather than JavaScript. There are versions of Blazor that execute the C# code within the ASP.NET Core server and entirely within the browser.

    

  


  Part 1.


  2 Getting started


  This chapter covers


  
    	Installing the code editor and SDK required for ASP.NET Core development


    	Creating a simple ASP.NET Core project


    	Responding to HTTP requests using a combination of code and markup

  


  The best way to appreciate a software development framework is to jump right in and use it. In this chapter, I explain how to prepare for ASP.NET Core development and how to create and run an ASP.NET Core application.


  2.1 Choosing a code editor


  Microsoft provides a choice of tools for ASP.NET Core development: Visual Studio and Visual Studio Code. Visual Studio is the traditional development environment for .NET applications, and it offers an enormous range of tools and features for developing all sorts of applications. But it can be resource-hungry and slow, and some of the features are so determined to be helpful they get in the way of development.


  Visual Studio Code is a lightweight alternative that doesn’t have the bells and whistles of Visual Studio but is perfectly capable of handling ASP.NET Core development.


  All the examples in this book include instructions for both editors, and both Visual Studio and Visual Studio Code can be used without charge, so you can use whichever suits your development style.


  If you are new to .NET development, then start with Visual Studio. It provides more structured support for creating the different types of files used in ASP.NET Core development, which will help ensure you get the expected results from the code examples.


  Note This book describes ASP.NET Core development for Windows. It is possible to develop and run ASP.NET Core applications on Linux and macOS, but most readers use Windows, and that is what I have chosen to focus on. Almost all the examples in this book rely on LocalDB, which is a Windows-only feature provided by SQL Server that is not available on other platforms. If you want to follow this book on another platform, then you can contact me using the email address in chapter 1, and I will try to help you get started.


  2.1.1 Installing Visual Studio


  ASP.NET Core 7 requires Visual Studio 2022. I use the free Visual Studio 2022 Community Edition, which can be downloaded from www.visualstudio.com. Run the installer, and you will see the prompt shown in figure 2.1.


  
    [image: ]


    Figure 2.1 Starting the Visual Studio installer

  


  Click the Continue button, and the installer will download the installation files, as shown in figure 2.2.
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    Figure 2.2 Downloading the Visual Studio installer files

  


  When the installer files have been downloaded, you will be presented with a set of installation options, grouped into workloads. Ensure that the “ASP.NET and web development” workload is checked, as shown in figure 2.3.
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    Figure 2.3 Selecting the workload

  


  Select the “Individual components” section at the top of the window and ensure the SQL Server Express 2019 LocalDB option is checked, as shown in figure 2.4. This is the database component that I will be using to store data in later chapters.
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    Figure 2.4 Ensuring LocalDB is installed

  


  Click the Install button, and the files required for the selected workload will be downloaded and installed. To complete the installation, a reboot may be required.


  Note You must also install the SDK, as described in the following section.


  2.1.2 Installing the .NET SDK


  The Visual Studio installer will install the .NET Software Development Kit (SDK), but it may not install the version required for the examples in this book. Go to https://dotnet.microsoft.com/download/dotnet-core/7.0 and download the installer for version 7.0.0 of the .NET SDK, which is the current release at the time of writing. Run the installer; once the installation is complete, open a new PowerShell command prompt from the Windows Start menu and run the command shown in listing 2.1, which displays a list of the installed .NET SDKs.


  Listing 2.1 Listing the Installed SDKs

  dotnet --list-sdks


  Here is the output from a fresh installation on a Windows machine that has not been used for .NET:

  7.0.100 [C:\Program Files\dotnet\sdk]


  If you have been working with different versions of .NET, you may see a longer list, like this one:

  5.0.100 [C:\Program Files\dotnet\sdk]
6.0.100 [C:\Program Files\dotnet\sdk]
6.0.113 [C:\Program Files\dotnet\sdk]
6.0.202 [C:\Program Files\dotnet\sdk]
6.0.203 [C:\Program Files\dotnet\sdk]
7.0.100 [C:\Program Files\dotnet\sdk]


  Regardless of how many entries there are, you must ensure there is one for the 7.0.1xx version, where the last two digits may differ.


  2.1.3 Installing Visual Studio Code


  If you have chosen to use Visual Studio Code, download the installer from https://code.visualstudio.com. No specific version is required, and you should select the current stable build. Run the installer and ensure you check the Add to PATH option, as shown in figure 2.5.
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    Figure 2.5 Configuring the Visual Studio Code installation

  


  Installing the .NET SDK


  The Visual Studio Code installer does not include the .NET SDK, which must be installed separately. Go to https://dotnet.microsoft.com/download/dotnet-core/7.0 and download the installer for version 7.0.0 of the .NET SDK. Run the installer; once the installation is complete, open a new PowerShell command prompt from the Windows Start menu and run the command shown in listing 2.2, which displays a list of the installed .NET SDKs.


  Listing 2.2 Listing the Installed SDKs

  dotnet --list-sdks


  Here is the output from a fresh installation on a Windows machine that has not been used for .NET:

  7.0.100 [C:\Program Files\dotnet\sdk]


  If you have been working with different versions of .NET, you may see a longer list, like this one:

  5.0.100 [C:\Program Files\dotnet\sdk]
6.0.100 [C:\Program Files\dotnet\sdk]
6.0.113 [C:\Program Files\dotnet\sdk]
6.0.202 [C:\Program Files\dotnet\sdk]
6.0.203 [C:\Program Files\dotnet\sdk]
7.0.100 [C:\Program Files\dotnet\sdk]


  Regardless of how many entries there are, you must ensure there is one for the 7.0.1xx version, where the last two digits may differ.


  Installing SQL Server LocalDB


  The database examples in this book require LocalDB, which is a zero-configuration version of SQL Server that can be installed as part of the SQL Server Express edition, which is available for use without charge from https://www.microsoft.com/en-in/sql-server/sql-server-downloads. Download and run the Express edition installer and select the Custom option, as shown in figure 2.6.
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    Figure 2.6 Selecting the installation option for SQL Server

  


  Once you have selected the Custom option, you will be prompted to select a download location for the installation files. Click the Install button, and the download will begin.


  When prompted, select the option to create a new SQL Server installation, as shown in figure 2.7.
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    Figure 2.7 Selecting an installation option

  


  Work through the installation process, selecting the default options as they are presented. When you reach the Feature Selection page, ensure that the LocalDB option is checked, as shown in figure 2.8. (You may want to uncheck the Machine Learning Services option, which is not used in this book and takes a long time to download and install.)
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    Figure 2.8 Selecting the LocalDB feature

  


  On the Instance Configuration page, select the “Default instance” option, as shown in figure 2.9.
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    Figure 2.9 Configuring the database

  


  Continue to work through the installation process, selecting the default values, and complete the installation.


  2.2 Creating an ASP.NET Core project


  The most direct way to create a project is to use the command line. Open a new PowerShell command prompt from the Windows Start menu, navigate to the folder where you want to create your ASP.NET Core projects, and run the commands shown in listing 2.3.


  Tip You can download the example project for this chapter—and for all the other chapters in this book—from https://github.com/manningbooks/pro-asp.net-core-7. See chapter 1 for how to get help if you have problems running the examples.


  Listing 2.3 Creating a new project

  dotnet new globaljson --sdk-version 7.0.100 --output FirstProject 
dotnet new mvc --no-https --output FirstProject --framework net7.0
dotnet new sln -o FirstProject
dotnet sln FirstProject add FirstProject


  The first command creates a folder named FirstProject and adds to it a file named global.json, which specifies the version of .NET that the project will use; this ensures you get the expected results when following the examples. The second command creates a new ASP.NET Core project. The .NET SDK includes a range of templates for starting new projects, and the mvc template is one of the options available for ASP.NET Core applications. This project template creates a project that is configured for the MVC Framework, which is one of the application types supported by ASP.NET Core. Don’t be intimidated by the idea of choosing a framework, and don’t worry if you have not heard of MVC—by the end of the book, you will understand the features that each offers and how they fit together. The remaining commands create a solution file, which allows multiple projects to be used together.


  Note This is one of a small number of chapters in which I use a project template that contains placeholder content. I don’t like using predefined project templates because they encourage developers to treat important features, such as authentication, as black boxes. My goal in this book is to give you the knowledge to understand and manage every aspect of your ASP.NET Core applications, and that’s why I start with an empty ASP.NET Core project. This chapter is about getting started quickly, for which the mvc template is well-suited.


  2.2.1 Opening the project using Visual Studio


  Start Visual Studio and click the “Open a project or solution” button, as shown in figure 2.10.
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    Figure 2.10 Opening the ASP.NET Core project

  


  Navigate to the FirstProject folder, select the FirstProject.sln file, and click the Open button. Visual Studio will open the project and display its contents in the Solution Explorer window, as shown in figure 2.11. The files in the project were created by the project template.
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    Figure 2.11 Opening the project in Visual Studio

  


  2.2.2 Opening the project with Visual Studio Code


  Start Visual Studio Code and select File > Open Folder. Navigate to the FirstProject folder and click the Select Folder button. Visual Studio Code will open the project and display its contents in the Explorer pane, as shown in figure 2.12. (The default dark theme used in Visual Studio Code doesn’t show well on the page, so I have changed to the light theme for the screenshots in this book.)
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    Figure 2.12 Opening the project in Visual Studio Code

  


  Additional configuration is required the first time you open a .NET project in Visual Studio Code. The first step is to click the Program.cs file in the Explorer pane. This will trigger a prompt from Visual Studio Code to install the features required for C# development, as shown in figure 2.13. If you have not opened a C# project before, you will see a prompt that offers to install the required assets, also shown in figure 2.13.
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    Figure 2.13 Installing Visual Studio Code C# features

  


  Click the Install or Yes button, as appropriate, and Visual Studio Code will download and install the features required for .NET projects.


  2.3 Running the ASP.NET Core application


  Visual Studio and Visual Studio Code can both run projects directly, but I use the command line tools throughout this book because they are more reliable and work more consistently, helping to ensure you get the expected results from the examples.


  When the project is created, a file named launchSettings.json is created in the Properties folder, and it is this file that determines which HTTP port ASP.NET Core will use to listen for HTTP requests. Open this file in your chosen editor and change the ports in the URLs it contains to 5000, as shown in listing 2.4.


  Listing 2.4 Setting the Port in the launchSettings.json File in the Properties Folder

  {
  "iisSettings": {
    "windowsAuthentication": false,
    "anonymousAuthentication": true,
    "iisExpress": {
      "applicationUrl": "http://localhost:5000",
      "sslPort": 0
    }
  },
  "profiles": {
    "FirstProject": {
      "commandName": "Project",
      "dotnetRunMessages": true,
      "launchBrowser": true,
      "applicationUrl": "http://localhost:5000",
      "environmentVariables": {
        "ASPNETCORE_ENVIRONMENT": "Development"
      }
    },
    "IIS Express": {
      "commandName": "IISExpress",
      "launchBrowser": true,
      "environmentVariables": {
        "ASPNETCORE_ENVIRONMENT": "Development"
      }
    }
  }
}


  It is only the URL in the profiles section that affects the .NET command-line tools, but I have changed both of them to avoid any problems. Open a new PowerShell command prompt from the Windows Start menu; navigate to the FirstProject project folder, which is the folder that contains the FirstProject.csproj file; and run the command shown in listing 2.5.


  Listing 2.5 Starting the example application

  dotnet run


  The dotnet run command compiles and starts the project. Once the application has started, open a new browser window and request http://localhost:5000, which will produce the response shown in figure 2.14.
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    Figure 2.14 Running the example project

  


  When you are finished, use Control+C to stop the ASP.NET Core application.


  2.3.1 Understanding endpoints


  In an ASP.NET Core application, incoming requests are handled by endpoints. The endpoint that produced the response in figure 2.14 is an action, which is a method that is written in C#. An action is defined in a controller, which is a C# class that is derived from the Microsoft.AspNetCore.Mvc.Controller class, the built-in controller base class.


  Each public method defined by a controller is an action, which means you can invoke the action method to handle an HTTP request. The convention in ASP.NET Core projects is to put controller classes in a folder named Controllers, which was created by the template used to set up the project.


  The project template added a controller to the Controllers folder to help jump-start development. The controller is defined in the class file named HomeController.cs. Controller classes contain a name followed by the word Controller, which means that when you see a file called HomeController.cs, you know that it contains a controller called Home, which is the default controller that is used in ASP.NET Core applications.


  Tip Don’t worry if the terms controller and action don’t make immediate sense. Just keep following the example, and you will see how the HTTP request sent by the browser is handled by C# code.


  Find the HomeController.cs file in the Solution Explorer or Explorer pane and click it to open it for editing. You will see the following code:

  using System.Diagnostics;
using Microsoft.AspNetCore.Mvc;
using FirstProject.Models;

namespace FirstProject.Controllers;

public class HomeController : Controller {
    private readonly ILogger<HomeController> _logger;
    public HomeController(ILogger<HomeController> logger) {
        _logger = logger;
    }
        
    public IActionResult Index() {
        return View();
    }
        
    public IActionResult Privacy() {
        return View();
    }
        
    [ResponseCache(Duration = 0, Location = ResponseCacheLocation.None, 
        NoStore = true)]
    public IActionResult Error() {
        return View(new ErrorViewModel { RequestId = Activity.Current?.Id 
            ?? HttpContext.TraceIdentifier });
    }
}


  Using the code editor, replace the contents of the HomeController.cs file so that it matches listing 2.6. I have removed all but one of the methods, changed the result type and its implementation, and removed the using statements for unused namespaces.


  Listing 2.6 Changing the HomeController.cs file in the Controllers folder

  using Microsoft.AspNetCore.Mvc;

namespace FirstProject.Controllers {

    public class HomeController : Controller {
        
        public string Index() {
            return "Hello World";
        }
    }
}


  The result is that the Home controller defines a single action, named Index. These changes don’t produce a dramatic effect, but they make for a nice demonstration. I have changed the method named Index so that it returns the string Hello World. Using the PowerShell prompt, run the dotnet run command in the FirstProject folder again and use the browser to request http://localhost:5000. The configuration of the project created by the template in listing 2.3 means the HTTP request will be processed by the Index action defined by the Home controller. Put another way, the request will be processed by the Index method defined by the HomeController class. The string produced by the Index method is used as the response to the browser’s HTTP request, as shown in figure 2.15.
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    Figure 2.15 The output from the action method

  


  2.3.2 Understanding routes


  The ASP.NET Core routing system is responsible for selecting the endpoint that will handle an HTTP request. A route is a rule that is used to decide how a request is handled. When the project was created, a default rule was created to get started. You can request any of the following URLs, and they will be dispatched to the Index action defined by the Home controller:


  
    	
      /

    


    	
      /Home

    


    	
      /Home/Index

    

  


  So, when a browser requests http://yoursite/ or http://yoursite/Home, it gets back the output from HomeController’s Index method. You can try this yourself by changing the URL in the browser. At the moment, it will be http://localhost:5000/. If you append /Home or /Home/Index to the URL and press Return, you will see the same Hello World result from the application.


  2.3.3 Understanding HTML rendering


  The output from the previous example wasn’t HTML—it was just the string Hello World. To produce an HTML response to a browser request, I need a view, which tells ASP.NET Core how to process the result produced by the Index method into an HTML response that can be sent to the browser.


  Creating and rendering a view


  The first thing I need to do is modify my Index action method, as shown in listing 2.7. The changes are shown in bold, which is a convention I follow throughout this book to make the examples easier to follow.


  Listing 2.7 Rendering a view in the HomeController.cs file in the Controllers folder

  using Microsoft.AspNetCore.Mvc;

namespace FirstProject.Controllers {

    public class HomeController : Controller {
        public ViewResult Index() {
            return View("MyView");
        }
    }
}


  When I return a ViewResult object from an action method, I am instructing ASP.NET Core to render a view. I create the ViewResult by calling the View method, specifying the name of the view that I want to use, which is MyView.


  Use Control+C to stop ASP.NET Core and then use the dotnet run command to compile and start it again. Use the browser to request http://localhost:5000, and you will see ASP.NET Core trying to find the view, as shown by the error message displayed in figure 2.16.
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    Figure 2.16 Trying to find a view

  


  This is a helpful error message. It explains that ASP.NET Core could not find the view I specified for the action method and explains where it looked. Views are stored in the Views folder, organized into subfolders. Views that are associated with the Home controller, for example, are stored in a folder called Views/Home. Views that are not specific to a single controller are stored in a folder called Views/Shared. The template used to create the project added the Home and Shared folders automatically and added some placeholder views to get the project started.


  If you are using Visual Studio, right-click the Views/Home folder in the Solution Explorer and select Add > New Item from the pop-up menu. Visual Studio will present you with a list of templates for adding items to the project. Locate the Razor View - Empty item, which can be found in the ASP.NET Core > Web > ASP.NET section, as shown in figure 2.17.


  For Visual Studio, you may need to click the Show All Templates button before the list of templates is displayed. Set the name of the new file to MyView.cshtml and click the Add button. Visual Studio will add a file named MyView.cshtml to the Views/Home folder and will open it for editing. Replace the contents of the file with those shown in listing 2.8.
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    Figure 2.17 Selecting a Visual Studio item template

  


  Visual Studio Code doesn’t provide item templates. Instead, right-click the Views/Home folder in the file explorer pane and select New File from the pop-up menu. Set the name of the file to MyView.cshtml and press Return. The file will be created and opened for editing. Add the content shown in listing 2.8.


  Tip It is easy to end up creating the view file in the wrong folder. If you didn’t end up with a file called MyView.cshtml in the Views/Home folder, then either drag the file into the correct folder or delete the file and try again.


  Listing 2.8 The contents of the MyView.cshtml file in the Views/Home folder

  @{
    Layout = null;
}

<!DOCTYPE html>

<html>
<head>
    <meta name="viewport" content="width=device-width" />
    <title>Index</title>
</head>
<body>
    <div>
        Hello World (from the view)
    </div>
</body>
</html>


  The new contents of the view file are mostly HTML. The exception is the part that looks like this:

  ...
@{
    Layout = null;
}
...


  This is an expression that will be interpreted by Razor, which is the component that processes the contents of views and generates HTML that is sent to the browser. Razor is a view engine, and the expressions in views are known as Razor expressions.


  The Razor expression in listing 2.8 tells Razor that I chose not to use a layout, which is like a template for the HTML that will be sent to the browser (and which I describe in chapter 22). To see the effect of creating the view, use Control+C to stop ASP.NET Core if it is running and use the dotnet run command to compile and start the application again. Use a browser to request http://localhost:5000, and you will see the result shown in figure 2.18.
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    Figure 2.18 Rendering a view

  


  When I first edited the Index action method, it returned a string value. This meant that ASP.NET Core did nothing except pass the string value as is to the browser. Now that the Index method returns a ViewResult, Razor is used to process a view and render an HTML response. Razor was able to locate the view because I followed the standard naming convention, which is to put view files in a folder whose name matched the controller that contains the action method. In this case, this meant putting the view file in the Views/Home folder, since the action method is defined by the Home controller.


  I can return other results from action methods besides strings and ViewResult objects. For example, if I return a RedirectResult, the browser will be redirected to another URL. If I return an HttpUnauthorizedResult, I can prompt the user to log in. These objects are collectively known as action results. The action result system lets you encapsulate and reuse common responses in actions. I’ll tell you more about them and explain the different ways they can be used in chapter 19.


  Adding dynamic output


  The whole point of a web application is to construct and display dynamic output. The job of the action method is to construct data and pass it to the view so it can be used to create HTML content based on the data values. Action methods provide data to views by passing arguments to the View method, as shown in listing 2.9. The data provided to the view is known as the view model.


  Listing 2.9 Using a view model in the HomeController.cs file in the Controllers folder

  using Microsoft.AspNetCore.Mvc;

namespace FirstProject.Controllers {

    public class HomeController : Controller {
 
        public ViewResult Index() {
            int hour = DateTime.Now.Hour;
            string viewModel = 
                hour < 12 ? "Good Morning" : "Good Afternoon";
            return View("MyView", viewModel);
        }
    }
}


  The view model in this example is a string, and it is provided to the view as the second argument to the View method. Listing 2.10 updates the view so that it receives and uses the view model in the HTML it generates.


  Listing 2.10 Using a view model in the MyView.cshtml file in the Views/Home folder

  @model string
@{
    Layout = null;
}

<!DOCTYPE html>

<html>
<head>
    <meta name="viewport" content="width=device-width" />
    <title>Index</title>
</head>
<body>
    <div>
        @Model World (from the view)
    </div>
</body>
</html>


  The type of the view model is specified using the @model expression, with a lowercase m. The view model value is included in the HTML output using the @Model expression, with an uppercase M. (It can be difficult at first to remember which is lowercase and which is uppercase, but it soon becomes second nature.)


  When the view is rendered, the view model data provided by the action method is inserted into the HTML response. Use Control+C to stop ASP.NET Core and use the dotnet run command to build and start it again. Use a browser to request http://localhost:5000, and you will see the output shown in figure 2.19 (although you may see the morning greeting if you are following this example before midday).
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    Figure 2.19 Generating dynamic content

  


  2.3.4 Putting the pieces together


  It is a simple result, but this example reveals all the building blocks you need to create a simple ASP.NET Core web application and to generate a dynamic response. The ASP.NET Core platform receives an HTTP request and uses the routing system to match the request URL to an endpoint. The endpoint, in this case, is the Index action method defined by the Home controller. The method is invoked and produces a ViewResult object that contains the name of a view and a view model object. The Razor view engine locates and processes the view, evaluating the @Model expression to insert the data provided by the action method into the response, which is returned to the browser and displayed to the user. There are, of course, many other features available, but this is the essence of ASP.NET Core, and it is worth bearing this simple sequence in mind as you read the rest of the book.


  Summary


  
    	
      ASP.NET Core development can be done with Visual Studio or Visual Studio Code, or you can choose your own code editor.

    


    	
      Most code editors provide integrated code builds, but the most reliable way to get consistent results across tools and platforms is by using the dotnet command.

    


    	
      ASP.NET Core relies on endpoints to process HTTP requests.

    


    	
      Endpoints can be written entirely in C# or use HTML that has been annotated with code expressions.

    

  


  3 Your first ASP.NET Core application


  This chapter covers


  
    	Using ASP.NET Core to create an application that accepts RSVP responses


    	Creating a simple data model


    	Creating a controller and view that presents and processes a form


    	Validating user data and displaying validation errors


    	Applying CSS styles to the HTML generated by the application

  


  Now that you are set up for ASP.NET Core development, it is time to create a simple application. In this chapter, you’ll create a data-entry application using ASP.NET Core. My goal is to demonstrate ASP.NET Core in action, so I will pick up the pace a little and skip over some of the explanations as to how things work behind the scenes. But don’t worry; I’ll revisit these topics in-depth in later chapters.


  3.1 Setting the scene


  Imagine that a friend has decided to host a New Year’s Eve party and that she has asked me to create a web app that allows her invitees to electronically RSVP. She has asked for these four key features:


  
    	
      A home page that shows information about the party

    


    	
      A form that can be used to RSVP

    


    	
      Validation for the RSVP form, which will display a thank-you page

    


    	
      A summary page that shows who is coming to the party

    

  


  In this chapter, I create an ASP.NET Core project and use it to create a simple application that contains these features; once everything works, I’ll apply some styling to improve the appearance of the finished application.


  3.2 Creating the project


  Open a PowerShell command prompt from the Windows Start menu, navigate to a convenient location, and run the commands in listing 3.1 to create a project named PartyInvites.


  Tip You can download the example project for this chapter—and for all the other chapters in this book—from https://github.com/manningbooks/pro-asp.net-core-7. See chapter 1 for how to get help if you have problems running the examples.


  Listing 3.1 Creating a new project

  dotnet new globaljson --sdk-version 7.0.100 --output PartyInvites
dotnet new mvc --no-https --output PartyInvites --framework net7.0
dotnet new sln -o PartyInvites
dotnet sln PartyInvites add PartyInvites


  These are the same commands I used to create the project in chapter 2. These commands ensure you get the right project starting point that uses the required version of .NET.


  3.2.1 Preparing the project


  Open the project (by opening the PartyInvites.sln file with Visual Studio or the PartyInvites folder in Visual Studio Code) and change the contents of the launchSettings.json file in the Properties folder, as shown in listing 3.2, to set the port that will be used to listen for HTTP requests.


  Listing 3.2 Setting ports in the launchSettings.json file in the Properties folder

  {
  "iisSettings": {
    "windowsAuthentication": false,
    "anonymousAuthentication": true,
    "iisExpress": {
      "applicationUrl": "http://localhost:5000",
      "sslPort": 0
    }
  },
  "profiles": {
    "PartyInvites": {
      "commandName": "Project",
      "dotnetRunMessages": true,
      "launchBrowser": true,
      "applicationUrl": "http://localhost:5000",
      "environmentVariables": {
        "ASPNETCORE_ENVIRONMENT": "Development"
      }
    },
    "IIS Express": {
      "commandName": "IISExpress",
      "launchBrowser": true,
      "environmentVariables": {
        "ASPNETCORE_ENVIRONMENT": "Development"
      }
    }
  }
}


  Replace the contents of the HomeController.cs file in the Controllers folder with the code shown in listing 3.3.


  Listing 3.3 The new contents of the HomeController.cs file in the Controllers folder

  using Microsoft.AspNetCore.Mvc;

namespace PartyInvites.Controllers {
    public class HomeController : Controller {
        
        public IActionResult Index() {
            return View();
        }
    }
}


  This provides a clean starting point for the new application, defining a single action method that selects the default view for rendering. To provide a welcome message to party invitees, open the Index.cshtml file in the Views/Home folder and replace the contents with those shown in listing 3.4.


  Listing 3.4 Replacing the contents of the Index.cshtml file in the Views/Home folder

  @{
    Layout = null;
}

<!DOCTYPE html>
<html>
<head>
    <meta name="viewport" content="width=device-width" />
    <title>Party!</title>
</head>
<body>
    <div>
        <div>
            We're going to have an exciting party.<br />
            (To do: sell it better. Add pictures or something.)
        </div>
    </div>
</body>
</html>


  Run the command shown in listing 3.5 in the PartyInvites folder to compile and execute the project.


  Listing 3.5 Compiling and running the project

  dotnet watch


  Once the project has started, a new browser window will be opened, and you will see the details of the party (well, the placeholder for the details, but you get the idea), as shown in figure 3.1.
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    Figure 3.1 Adding to the view HTML

  


  Leave the dotnet watch command running. As you make changes to the project, you will see that the code is automatically recompiled and that changes are automatically displayed in the browser.


  If you make a mistake following the examples, you may find that the dotnet watch command indicates that it can’t automatically update the browser. If that happens, select the option to restart the application.


  3.2.2 Adding a data model


  The data model is the most important part of any ASP.NET Core application. The model is the representation of the real-world objects, processes, and rules that define the subject, known as the domain, of the application. The model, often referred to as a domain model, contains the C# objects (known as domain objects) that make up the universe of the application and the methods that manipulate them. In most projects, the job of the ASP.NET Core application is to provide the user with access to the data model and the features that allow the user to interact with it.


  The convention for an ASP.NET Core application is that the data model classes are defined in a folder named Models, which was added to the project by the template used in listing 3.1.


  I don’t need a complex model for the PartyInvites project because it is such a simple application. I need just one domain class that I will call GuestResponse. This object will represent an RSVP from an invitee.


  If you are using Visual Studio, right-click the Models folder and select Add > Class from the pop-up menu. Set the name of the class to GuestResponse.cs and click the Add button. If you are using Visual Studio Code, right-click the Models folder, select New File, and enter GuestResponse.cs as the file name. Use the new file to define the class shown in listing 3.6.


  Listing 3.6 The contents of the GuestResponse.cs file in the Models folder

  namespace PartyInvites.Models {

    public class GuestResponse {
 
        public string? Name { get; set; }
        public string? Email { get; set; }
        public string? Phone { get; set; }
        public bool? WillAttend { get; set; }
    }
}


  Notice that all the properties defined by the GuestResponse class are nullable. I explain why this is important in the “Adding Validation” section later in the chapter.


  
    Restarting the automatic build


    You may see a warning produced by the dotnet watch command telling you that a hot reload cannot be applied. The dotnet watch command can’t cope with every type of change, and some changes cause the automatic rebuild process to fail. You will see this prompt at the command line:

    watch : Do you want to restart your app 
    - Yes (y) / No (n) / Always (a) / Never (v)?


    Press a to always rebuild the project. Microsoft makes frequent improvements to the dotnet watch command and so the actions that trigger this problem change.

  


  3.2.3 Creating a second action and view


  One of my application goals is to include an RSVP form, which means I need to define an action method that can receive requests for that form. A single controller class can define multiple action methods, and the convention is to group related actions in the same controller. Listing 3.7 adds a new action method to the Home controller. Controllers can return different result types, which are explained in later chapters.


  Listing 3.7 Adding an action in the HomeController.cs file in the Controllers folder

  using Microsoft.AspNetCore.Mvc;

namespace PartyInvites.Controllers {
    public class HomeController : Controller {
        
        public IActionResult Index() {
            return View();
        }
 
        public ViewResult RsvpForm() {
            return View();
        }
    }
}


  Both action methods invoke the View method without arguments, which may seem odd, but remember that the Razor view engine will use the name of the action method when looking for a view file, as explained in chapter 2. That means the result from the Index action method tells Razor to look for a view called Index.cshtml, while the result from the RsvpForm action method tells Razor to look for a view called RsvpForm.cshtml.


  If you are using Visual Studio, right-click the Views/Home folder and select Add > New Item from the pop-up menu. Select the Razor View – Empty item, set the name to RsvpForm.cshtml, and click the Add button to create the file. Replace the contents with those shown in listing 3.8.


  If you are using Visual Studio Code, right-click the Views/Home folder and select New File from the pop-up menu. Set the name of the file to RsvpForm.cshtml and add the contents shown in listing 3.8.


  Listing 3.8 The contents of the RsvpForm.cshtml file in the Views/Home folder

  @{
    Layout = null;
}

<!DOCTYPE html>
<html>
<head>
    <meta name="viewport" content="width=device-width" />
    <title>RsvpForm</title>
</head>
<body>
    <div>
        This is the RsvpForm.cshtml View
    </div>
</body>
</html>


  This content is just static HTML for the moment. Use the browser to request http://localhost:5000/home/rsvpform. The Razor view engine locates the RsvpForm.cshtml file and uses it to produce a response, as shown in figure 3.2.
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    Figure 3.2 Rendering a second view

  


  3.2.4 Linking action methods


  I want to be able to create a link from the Index view so that guests can see the RsvpForm view without having to know the URL that targets a specific action method, as shown in listing 3.9.


  Listing 3.9 Adding a link in the Index.cshtml file in the Views/Home folder

  @{
    Layout = null;
}

<!DOCTYPE html>
<html>
<head>
    <meta name="viewport" content="width=device-width" />
    <title>Party!</title>
</head>
<body>
    <div>
        <div>
            We're going to have an exciting party.<br />
            (To do: sell it better. Add pictures or something.)
        </div>
        <a asp-action="RsvpForm">RSVP Now</a>
    </div>
</body>
</html>


  The addition to the listing is an a element that has an asp-action attribute. The attribute is an example of a tag helper attribute, which is an instruction for Razor that will be performed when the view is rendered. The asp-action attribute is an instruction to add an href attribute to the a element that contains a URL for an action method. I explain how tag helpers work in chapters 25–27, but this tag helper tells Razor to insert a URL for an action method defined by the same controller for which the current view is being rendered.


  Use the browser to request http://localhost:5000, and you will see the link that the helper has created, as shown in figure 3.3.
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    Figure 3.3 Linking between action methods

  


  Roll the mouse over the RSVP Now link in the browser. You will see that the link points to http://localhost:5000/Home/RsvpForm.


  There is an important principle at work here, which is that you should use the features provided by ASP.NET Core to generate URLs, rather than hard-code them into your views. When the tag helper created the href attribute for the a element, it inspected the configuration of the application to figure out what the URL should be. This allows the configuration of the application to be changed to support different URL formats without needing to update any views.


  3.2.5 Building the form


  Now that I have created the view and can reach it from the Index view, I am going to build out the contents of the RsvpForm.cshtml file to turn it into an HTML form for editing GuestResponse objects, as shown in listing 3.10.


  Listing 3.10 Creating a form view in the RsvpForm.cshtml file in the Views/Home folder

  @model PartyInvites.Models.GuestResponse
@{
    Layout = null;
}

<!DOCTYPE html>

<html>
<head>
    <meta name="viewport" content="width=device-width" />
    <title>RsvpForm</title>
</head>
<body>
    <form asp-action="RsvpForm" method="post">
        <div>
            <label asp-for="Name">Your name:</label>
            <input asp-for="Name" />
        </div>
        <div>
            <label asp-for="Email">Your email:</label>
            <input asp-for="Email" />
        </div>
        <div>
            <label asp-for="Phone">Your phone:</label>
            <input asp-for="Phone" />
        </div>
        <div>
            <label asp-for="WillAttend">Will you attend?</label>
            <select asp-for="WillAttend">
                <option value="">Choose an option</option>
                <option value="true">Yes, I'll be there</option>
                <option value="false">No, I can't come</option>
            </select>
        </div>
        <button type="submit">Submit RSVP</button>
    </form>
</body>
</html>


  The @model expression specifies that the view expects to receive a GuestResponse object as its view model. I have defined a label and input element for each property of the GuestResponse model class (or, in the case of the WillAttend property, a select element). Each element is associated with the model property using the asp-for attribute, which is another tag helper attribute. The tag helper attributes configure the elements to tie them to the view model object. Here is an example of the HTML that the tag helpers produce:

  <p>
    <label for="Name">Your name:</label>
    <input type="text" id="Name" name="Name" value="">
</p>


  The asp-for attribute on the label element sets the value of the for attribute. The asp-for attribute on the input element sets the id and name elements. This may not look especially useful, but you will see that associating elements with a model property offers additional advantages as the application functionality is defined.


  Of more immediate use is the asp-action attribute applied to the form element, which uses the application’s URL routing configuration to set the action attribute to a URL that will target a specific action method, like this:

  <form method="post" action="/Home/RsvpForm">


  As with the helper attribute I applied to the a element, the benefit of this approach is that when you change the system of URLs that the application uses, the content generated by the tag helpers will reflect the changes automatically.


  Use the browser to request http://localhost:5000 and click the RSVP Now link to see the form, as shown in figure 3.4.
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    Figure 3.4 Adding an HTML form to the application

  


  3.2.6 Receiving form data


  I have not yet told ASP.NET Core what I want to do when the form is posted to the server. As things stand, clicking the Submit RSVP button just clears any values you have entered in the form. That is because the form posts back to the RsvpForm action method in the Home controller, which just renders the view again. To receive and process submitted form data, I am going to use an important feature of controllers. I will add a second RsvpForm action method to create the following:


  
    	
      A method that responds to HTTP GET requests: A GET request is what a browser issues normally each time someone clicks a link. This version of the action will be responsible for displaying the initial blank form when someone first visits /Home/RsvpForm.

    


    	
      A method that responds to HTTP POST requests: The form element defined in listing 3.10 sets the method attribute to post, which causes the form data to be sent to the server as a POST request. This version of the action will be responsible for receiving submitted data and deciding what to do with it.

    

  


  Handling GET and POST requests in separate C# methods helps to keep my controller code tidy since the two methods have different responsibilities. Both action methods are invoked by the same URL, but ASP.NET Core makes sure that the appropriate method is called, based on whether I am dealing with a GET or POST request. Listing 3.11 shows the changes to the HomeController class.


  Listing 3.11 Adding a method in the HomeController.cs file in the Controllers folder

  using Microsoft.AspNetCore.Mvc;
using PartyInvites.Models;

namespace PartyInvites.Controllers {
    public class HomeController : Controller {
        
        public IActionResult Index() {
            return View();
        }
 
        [HttpGet]
        public ViewResult RsvpForm() {
            return View();
        }
 
        [HttpPost]
        public ViewResult RsvpForm(GuestResponse guestResponse) {
            // TODO: store response from guest
            return View();
        }
    }
}


  I have added the HttpGet attribute to the existing RsvpForm action method, which declares that this method should be used only for GET requests. I then added an overloaded version of the RsvpForm method, which accepts a GuestResponse object. I applied the HttpPost attribute to this method, which declares it will deal with POST requests. I explain how these additions to the listing work in the following sections. I also imported the PartyInvites.Models namespace—this is just so I can refer to the GuestResponse model type without needing to qualify the class name.


  Understanding model binding


  The first overload of the RsvpForm action method renders the same view as before—the RsvpForm.cshtml file—to generate the form shown in figure 3.4. The second overload is more interesting because of the parameter, but given that the action method will be invoked in response to an HTTP POST request and that the GuestResponse type is a C# class, how are the two connected?


  The answer is model binding, a useful ASP.NET Core feature whereby incoming data is parsed and the key-value pairs in the HTTP request are used to populate properties of domain model types.


  Model binding is a powerful and customizable feature that eliminates the grind of dealing with HTTP requests directly and lets you work with C# objects rather than dealing with individual data values sent by the browser. The GuestResponse object that is passed as the parameter to the action method is automatically populated with the data from the form fields. I dive into the details of model binding in chapter 28.


  To demonstrate how model binding works, I need to do some preparatory work. One of the application goals is to present a summary page with details of who is attending the party, which means that I need to keep track of the responses that I receive. I am going to do this by creating an in-memory collection of objects. This isn’t useful in a real application because the response data will be lost when the application is stopped or restarted, but this approach will allow me to keep the focus on ASP.NET Core and create an application that can easily be reset to its initial state. Later chapters will demonstrate persistent data storage.


  Add a class file named Repository.cs to the Models folder and use it to define the class shown in listing 3.12.


  Listing 3.12 The contents of the Repository.cs file in the Models folder

  namespace PartyInvites.Models {
    public static class Repository {
        private static List<GuestResponse> responses = new();
 
        public static IEnumerable<GuestResponse> Responses => responses;
 
        public static void AddResponse(GuestResponse response) {
            Console.WriteLine(response);
            responses.Add(response);
        }
    }
}


  The Repository class and its members are static, which will make it easy for me to store and retrieve data from different places in the application. ASP.NET Core provides a more sophisticated approach for defining common functionality, called dependency injection, which I describe in chapter 14, but a static class is a good way to get started for a simple application like this one.


  If you are using Visual Studio, saving the contents of the Repository.cs file will trigger a warning produced by the dotnet watch command telling you that a hot reload cannot be applied, which is the same warning described earlier in the chapter for Visual Studio Code users. You will see this prompt at the command line:

  watch : Do you want to restart your app 
    - Yes (y) / No (n) / Always (a) / Never (v)?


  Press a to always rebuild the project.


  Storing responses


  Now that I have somewhere to store the data, I can update the action method that receives the HTTP POST requests, as shown in listing 3.13.


  Listing 3.13 Updating an action in the HomeController.cs file in the Controllers folder

  using Microsoft.AspNetCore.Mvc;
using PartyInvites.Models;

namespace PartyInvites.Controllers {
    public class HomeController : Controller {
        
        public IActionResult Index() {
            return View();
        }
                
        [HttpGet]
        public ViewResult RsvpForm() {
            return View();
        }
                
        [HttpPost]
        public ViewResult RsvpForm(GuestResponse guestResponse) {
            Repository.AddResponse(guestResponse);
            return View("Thanks", guestResponse);
        }
    }
}


  Before the POST version of the RsvpForm method is invoked, the ASP.NET Core model binding feature extracts values from the HTML form and assigns them to the properties of the GuestResponse object. The result is used as the argument when the method is invoked to handle the HTTP request, and all I have to do to deal with the form data sent in a request is to work with the GuestResponse object that is passed to the action method—in this case, to pass it as an argument to the Repository.AddResponse method so t hat the response can be stored.


  3.2.7 Adding the Thanks view


  The call to the View method in the RsvpForm action method creates a ViewResult that selects a view called Thanks and uses the GuestResponse object created by the model binder as the view model. Add a Razor View named Thanks.cshtml to the Views/Home folder with the content shown in listing 3.14 to present a response to the user.


  Listing 3.14 The contents of the Thanks.cshtml file in the Views/Home folder

  @model PartyInvites.Models.GuestResponse
@{
    Layout = null;
}

<!DOCTYPE html>
<html>
<head>
    <meta name="viewport" content="width=device-width" />
    <title>Thanks</title>
</head>
<body>
    <div>
        <h1>Thank you, @Model?.Name!</h1>
        @if (Model?.WillAttend == true) {
            @:It's great that you're coming. 
            @:The drinks are already in the fridge!
        } else {
            @:Sorry to hear that you can't make it, 
            @:but thanks for letting us know.
        }
    </div>
    Click <a asp-action="ListResponses">here</a> to see who is coming.
</body>
</html>


  The HTML produced by the Thanks.cshtml view depends on the values assigned to the GuestResponse view model provided by the RsvpForm action method. To access the value of a property in the domain object, I use an @Model.<PropertyName> expression. So, for example, to get the value of the Name property, I use the @Model.Name expression. Don’t worry if the Razor syntax doesn’t make sense—I explain it in more detail in chapter 21.


  Now that I have created the Thanks view, I have a basic working example of handling a form. Use the browser to request http://localhost:5000, click the RSVP Now link, add some data to the form, and click the Submit RSVP button. You will see the response shown in figure 3.5 (although it will differ if your name is not Joe or you said you could not attend).
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    Figure 3.5 The Thanks view

  


  3.2.8 Displaying responses


  At the end of the Thanks.cshtml view, I added an a element to create a link to display the list of people who are coming to the party. I used the asp-action tag helper attribute to create a URL that targets an action method called ListResponses, like this:

  ...
Click <a asp-action="ListResponses">here</a> to see who is coming.
...


  If you hover the mouse over the link that is displayed by the browser, you will see that it targets the /Home/ListResponses URL. This doesn’t correspond to any of the action methods in the Home controller, and if you click the link, you will see a 404 Not Found error response.


  To add an endpoint that will handle the URL, I need to add another action method to the Home controller, as shown in listing 3.15.


  Listing 3.15 Adding an action in the HomeController.cs file in the Controllers folder

  using Microsoft.AspNetCore.Mvc;
using PartyInvites.Models;

namespace PartyInvites.Controllers {
    public class HomeController : Controller {
 
        public IActionResult Index() {
            return View();
        }
 
        [HttpGet]
        public ViewResult RsvpForm() {
            return View();
        }
 
        [HttpPost]
        public ViewResult RsvpForm(GuestResponse guestResponse) {
            Repository.AddResponse(guestResponse);
            return View("Thanks", guestResponse);
        }
 
        public ViewResult ListResponses() {
            return View(Repository.Responses
                .Where(r => r.WillAttend == true));
        }
    }
}


  The new action method is called ListResponses, and it calls the View method, using the Repository.Responses property as the argument. This will cause Razor to render the default view, using the action method name as the name of the view file, and to use the data from the repository as the view model. The view model data is filtered using LINQ so that only positive responses are provided to the view.


  Add a Razor View named ListResponses.cshtml to the Views/Home folder with the content shown in listing 3.16.


  Listing 3.16 Displaying data in the ListResponses.cshtml file in the Views/Home folder

  @model IEnumerable<PartyInvites.Models.GuestResponse>
@{
    Layout = null;
}

<!DOCTYPE html>

<html>
<head>
    <meta name="viewport" content="width=device-width" />
    <title>Responses</title>
</head>
<body>
    <h2>Here is the list of people attending the party</h2>
    <table>
        <thead>
            <tr><th>Name</th><th>Email</th><th>Phone</th></tr>
        </thead>
        <tbody>
            @foreach (PartyInvites.Models.GuestResponse r in Model!) {
                <tr>
                    <td>@r.Name</td>
                    <td>@r.Email</td>
                    <td>@r.Phone</td>
                </tr>
            }
        </tbody>
    </table>
</body>
</html>


  Razor view files have the .cshtml file extension to denote a mix of C# code and HTML elements. You can see this in listing 3.16 where I have used an @foreach expression to process each of the GuestResponse objects that the action method passes to the view using the View method. Unlike a normal C# foreach loop, the body of a Razor @foreach expression contains HTML elements that are added to the response that will be sent back to the browser. In this view, each GuestResponse object generates a tr element that contains td elements populated with the value of an object property.


  Use the browser to request http://localhost:5000, click the RSVP Now link, and fill in the form. Submit the form and then click the link to see a summary of the data that has been entered since the application was first started, as shown in figure 3.6. The view does not present the data in an appealing way, but it is enough for the moment, and I will address the styling of the application later in this chapter.
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    Figure 3.6 Showing a list of party attendees

  


  3.2.9 Adding validation


  I can now add data validation to the application. Without validation, users could enter nonsense data or even submit an empty form. In an ASP.NET Core application, validation rules are defined by applying attributes to model classes, which means the same validation rules can be applied in any form that uses that class. ASP.NET Core relies on attributes from the System.ComponentModel.DataAnnotations namespace, which I have applied to the GuestResponse class in listing 3.17.


  Listing 3.17 Applying validation in the GuestResponse.cs file in the Models folder

  using System.ComponentModel.DataAnnotations;

namespace PartyInvites.Models {

    public class GuestResponse {
 
        [Required(ErrorMessage = "Please enter your name")]
        public string? Name { get; set; }
 
        [Required(ErrorMessage = "Please enter your email address")]
        [EmailAddress]
        public string? Email { get; set; }
 
        [Required(ErrorMessage = "Please enter your phone number")]
        public string? Phone { get; set; }
 
        [Required(ErrorMessage = "Please specify whether you'll attend")]
        public bool? WillAttend { get; set; }
    }
}


  ASP.NET Core detects the attributes and uses them to validate data during the model-binding process.


  As noted earlier, I used nullable types to define the GuestResponse properties. This is useful for denoting properties that may not be assigned values, but it has a special value for the WillAttend property because it allows the Required validation attribute to work. If I had used a regular non-nullable bool, the value I received through modelbinding could be only true or false, and I would not be able to tell whether the user had selected a value. A nullable bool has three possible values: true, false, and null. The value of the WillAttend property will be null if the user has not selected a value, and this causes the Required attribute to report a validation error. This is a nice example of how ASP.NET Core elegantly blends C# features with HTML and HTTP.


  I check to see whether there has been a validation problem using the ModelState.IsValid property in the action method that receives the form data, as shown in listing 3.18.


  Listing 3.18 Checking for errors in the HomeController.cs file in the Controllers folder

  using Microsoft.AspNetCore.Mvc;
using PartyInvites.Models;

namespace PartyInvites.Controllers {
    public class HomeController : Controller {
 
        public IActionResult Index() {
            return View();
        }
 
        [HttpGet]
        public ViewResult RsvpForm() {
            return View();
        }
 
        [HttpPost]
        public ViewResult RsvpForm(GuestResponse guestResponse) {
            if (ModelState.IsValid) {
                Repository.AddResponse(guestResponse);
                return View("Thanks", guestResponse);
            } else {
                return View();
            }
        }
 
        public ViewResult ListResponses() {
            return View(Repository.Responses
                .Where(r => r.WillAttend == true));
        }
    }
}


  The Controller base class provides a property called ModelState that provides details of the outcome of the model binding process. If the ModelState.IsValid property returns true, then I know that the model binder has been able to satisfy the validation constraints I specified through the attributes on the GuestResponse class. When this happens, I render the Thanks view, just as I did previously.


  If the ModelState.IsValid property returns false, then I know that there are validation errors. The object returned by the ModelState property provides details of each problem that has been encountered, but I don’t need to get into that level of detail because I can rely on a useful feature that automates the process of asking the user to address any problems by calling the View method without any parameters.


  When it renders a view, Razor has access to the details of any validation errors associated with the request, and tag helpers can access the details to display validation errors to the user. Listing 3.19 shows the addition of validation tag helper attributes to the RsvpForm view.


  Listing 3.19 Adding a summary to the RsvpForm.cshtml file in the Views/Home folder

  @model PartyInvites.Models.GuestResponse
@{
    Layout = null;
}

<!DOCTYPE html>

<html>
<head>
    <meta name="viewport" content="width=device-width" />
    <title>RsvpForm</title>
</head>
<body>
    <form asp-action="RsvpForm" method="post">
        <div asp-validation-summary="All"></div>
        <div>
            <label asp-for="Name">Your name:</label>
            <input asp-for="Name" />
        </div>
        <div>
            <label asp-for="Email">Your email:</label>
            <input asp-for="Email" />
        </div>
        <div>
            <label asp-for="Phone">Your phone:</label>
            <input asp-for="Phone" />
        </div>
        <div>
            <label asp-for="WillAttend">Will you attend?</label>
            <select asp-for="WillAttend">
                <option value="">Choose an option</option>
                <option value="true">Yes, I'll be there</option>
                <option value="false">No, I can't come</option>
            </select>
        </div>
        <button type="submit">Submit RSVP</button>
    </form>
</body>
</html>


  The asp-validation-summary attribute is applied to a div element, and it displays a list of validation errors when the view is rendered. The value for the asp-validation-summary attribute is a value from an enumeration called ValidationSummary, which specifies what types of validation errors the summary will contain. I specified All, which is a good starting point for most applications, and I describe the other values and explain how they work in chapter 29.


  To see how the validation summary works, run the application, fill out the Name field, and submit the form without entering any other data. You will see a summary of validation errors, as shown in figure 3.7.
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    Figure 3.7 Displaying validation errors

  


  The RsvpForm action method will not render the Thanks view until all the validation constraints applied to the GuestResponse class have been satisfied. Notice that the data entered in the Name field was preserved and displayed again when Razor rendered the view with the validation summary. This is another benefit of model binding, and it simplifies working with form data.


  Highlighting invalid fields


  The tag helper attributes that associate model properties with elements have a handy feature that can be used in conjunction with model binding. When a model class property has failed validation, the helper attributes will generate slightly different HTML. Here is the input element that is generated for the Phone field when there is no validation error:

  <input type="text" data-val="true"
     data-val-required="Please enter your phone number" id="Phone"
     name="Phone" value="">


  For comparison, here is the same HTML element after the user has submitted the form without entering data into the text field (which is a validation error because I applied the Required attribute to the Phone property of the GuestResponse class):

  <input type="text" class="input-validation-error"
     data-val="true" data-val-required="Please enter your phone number" id="Phone"
     name="Phone" value="">


  I have highlighted the difference: the asp-for tag helper attribute added the input element to a class called input-validation-error. I can take advantage of this feature by creating a stylesheet that contains CSS styles for this class and the others that different HTML helper attributes use.


  The convention in ASP.NET Core projects is that static content is placed into the wwwroot folder and organized by content type so that CSS stylesheets go into the wwwroot/css folder, JavaScript files go into the wwwroot/js folder, and so on.


  Tip The project template used in listing 3.1 creates a site.css file in the wwwroot/css folder. You can ignore this file, which I don’t use in this chapter.


  If you are using Visual Studio, right-click the wwwroot/css folder and select Add > New Item from the pop-up menu. Locate the Style Sheet item template, as shown in figure 3.8; set the name of the file to styles.css; and click the Add button.
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    Figure 3.8 Creating a CSS stylesheet

  


  If you are using Visual Studio Code, right-click the wwwroot/css folder, select New File from the pop-up menu, and use styles.css as the file name. Regardless of which editor you use, replace the contents of the file with the styles shown in listing 3.20.


  Listing 3.20 The contents of the styles.css file in the wwwroot/css folder

  .field-validation-error {
    color: #f00;
}

.field-validation-valid {
    display: none;
}

.input-validation-error {
    border: 1px solid #f00;
    background-color: #fee;
}

.validation-summary-errors {
    font-weight: bold;
    color: #f00;
}

.validation-summary-valid {
    display: none;
}


  To apply this stylesheet, I added a link element to the head section of the RsvpForm view, as shown in listing 3.21.


  Listing 3.21 Applying a stylesheet in the RsvpForm.cshtml file in the Views/Home folder

  ...
<head>
    <meta name="viewport" content="width=device-width" />
    <title>RsvpForm</title>
    <link rel="stylesheet" href="/css/styles.css" />
</head>
...


  The link element uses the href attribute to specify the location of the stylesheet. Notice that the wwwroot folder is omitted from the URL. The default configuration for ASP.NET includes support for serving static content, such as images, CSS stylesheets, and JavaScript files, and it maps requests to the wwwroot folder automatically. With the application of the stylesheet, a more obvious validation error will be displayed when data is submitted that causes a validation error, as shown in figure 3.9.
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    Figure 3.9 Automatically highlighted validation errors

  


  3.2.10 Styling the content


  All the functional goals for the application are complete, but the overall appearance of the application is poor. When you create a project using the mvc template, as I did for the example in this chapter, some common client-side development packages are installed. While I am not a fan of using template projects, I do like the client-side libraries that Microsoft has chosen. One of them is called Bootstrap, which is a good CSS framework originally developed by Twitter that has become a major open-source project and a mainstay of web application development.


  Styling the welcome view


  The basic Bootstrap features work by applying classes to elements that correspond to CSS selectors defined in the files added to the wwwroot/lib/bootstrap folder. You can get full details of the classes that Bootstrap defines from http://getbootstrap.com, but you can see how I have applied some basic styling to the Index.cshtml view file in listing 3.22.


  Listing 3.22 Adding Bootstrap to the Index.cshtml file in the Views/Home folder

  @{
    Layout = null;
}

<!DOCTYPE html>

<html>
<head>
    <meta name="viewport" content="width=device-width" />
    <link rel="stylesheet" href="/lib/bootstrap/dist/css/bootstrap.css" />
    <title>Index</title>
</head>
<body>
    <div class="text-center m-2">
        <h3> We're going to have an exciting party!</h3>
        <h4>And YOU are invited!</h4>
        <a class="btn btn-primary" asp-action="RsvpForm">RSVP Now</a>
    </div>
</body>
</html>


  I have added a link element whose href attribute loads the bootstrap.css file from the wwwroot/lib/bootstrap/dist/css folder. The convention is that third-party CSS and JavaScript packages are installed into the wwwroot/lib folder, and I describe the tool that is used to manage these packages in chapter 4.


  Having imported the Bootstrap stylesheets, I need to style my elements. This is a simple example, so I need to use only a small number of Bootstrap CSS classes: text-center, btn, and btn-primary.


  The text-center class centers the contents of an element and its children. The btn class styles a button, input, or a element as a pretty button, and the btn-primary class specifies which of a range of colors I want the button to be. You can see the effect by running the application, as shown in figure 3.10.
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    Figure 3.10 Styling a view

  


  It will be obvious to you that I am not a web designer. In fact, as a child, I was excused from art lessons on the basis that I had absolutely no talent whatsoever. This had the happy result of making more time for math lessons but meant that my artistic skills have not developed beyond those of the average 10-year-old. For a real project, I would seek a professional to help design and style the content, but for this example, I am going it alone, and that means applying Bootstrap with as much restraint and consistency as I can muster.


  Styling the form view


  Bootstrap defines classes that can be used to style forms. I am not going to go into detail, but you can see how I have applied these classes in listing 3.23.


  Listing 3.23 Adding styles to the RsvpForm.cshtml file in the Views/Home folder

  @model PartyInvites.Models.GuestResponse
@{
    Layout = null;
}

<!DOCTYPE html>

<html>
<head>
    <meta name="viewport" content="width=device-width" />
    <title>RsvpForm</title>
    <link rel="stylesheet" href="/lib/bootstrap/dist/css/bootstrap.css" />
    <link rel="stylesheet" href="/css/styles.css" />
</head>
<body>
    <h5 class="bg-primary text-white text-center m-2 p-2">RSVP</h5>
    <form asp-action="RsvpForm" method="post" class="m-2">
        <div asp-validation-summary="All"></div>
        <div class="form-group">
            <label asp-for="Name" class="form-label">Your name:</label>
            <input asp-for="Name" class="form-control" />
        </div>
        <div class="form-group">
            <label asp-for="Email" class="form-label">Your email:</label>
            <input asp-for="Email"  class="form-control" />
        </div>
        <div class="form-group">
            <label asp-for="Phone" class="form-label">Your phone:</label>
            <input asp-for="Phone" class="form-control" />
        </div>
        <div class="form-group">
            <label asp-for="WillAttend" class="form-label">
                Will you attend?
            </label>
            <select asp-for="WillAttend" class="form-select">
                <option value="">Choose an option</option>
                <option value="true">Yes, I'll be there</option>
                <option value="false">No, I can't come</option>
            </select>
        </div>
        <button type="submit" class="btn btn-primary mt-3">
            Submit RSVP
        </button>
    </form>
</body>
</html>


  The Bootstrap classes in this example create a header, just to give structure to the layout. To style the form, I have used the form-group class, which is used to style the element that contains the label and the associated input or select element, which is assigned to the form-control class. You can see the effect of the styles in figure 3.11.
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    Figure 3.11 Styling the RsvpForm view

  


  Styling the thanks view


  The next view file to style is Thanks.cshtml, and you can see how I have done this in listing 3.24, using CSS classes that are similar to the ones I used for the other views. To make an application easier to manage, it is a good principle to avoid duplicating code and markup wherever possible. ASP.NET Core provides several features to help reduce duplication, which I describe in later chapters. These features include Razor layouts (Chapter 22), partial views (Chapter 22), and view components (Chapter 24).


  Listing 3.24 Applying styles to the Thanks.cshtml file in the Views/Home folder

  @model PartyInvites.Models.GuestResponse
@{
    Layout = null;
}

<!DOCTYPE html>

<html>
<head>
    <meta name="viewport" content="width=device-width" />
    <title>Thanks</title>
        <link rel="stylesheet" 
            href="/lib/bootstrap/dist/css/bootstrap.css" />
</head>
<body class="text-center">
    <div>
        <h1>Thank you, @Model?.Name!</h1>
        @if (Model?.WillAttend == true) {
            @:It's great that you're coming. 
            @:The drinks are already in the fridge!
        } else {
            @:Sorry to hear that you can't make it, 
            @:but thanks for letting us know.
        }
    </div>
    Click <a asp-action="ListResponses">here</a> to see who is coming.
</body>
</html>


  Figure 3.12 shows the effect of the styles.
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    Figure 3.12 Styling the Thanks view

  


  Styling the list view


  The final view to style is ListResponses, which presents the list of attendees. Styling the content follows the same approach as used for the other views, as shown in listing 3.25.


  Listing 3.25 Adding styles to the ListResponses.cshtml file in the Views/Home folder

  @model IEnumerable<PartyInvites.Models.GuestResponse>
@{
    Layout = null;
}

<!DOCTYPE html>

<html>
<head>
    <meta name="viewport" content="width=device-width" />
    <title>Responses</title>
    <link rel="stylesheet" href="/lib/bootstrap/dist/css/bootstrap.css" />
</head>
<body>
    <div class="text-center p-2">
        <h2 class="text-center">
            Here is the list of people attending the party
        </h2>
        <table class="table table-bordered table-striped table-sm">
            <thead>
                <tr><th>Name</th><th>Email</th><th>Phone</th></tr>
            </thead>
            <tbody>
                @foreach (PartyInvites.Models.GuestResponse r in Model!) {
                    <tr>
                        <td>@r.Name</td>
                        <td>@r.Email</td>
                        <td>@r.Phone</td>
                    </tr>
                }
            </tbody>
        </table>
    </div>
</body>
</html>


  Figure 3.13 shows the way that the table of attendees is presented. Adding these styles to the view completes the example application, which now meets all the development goals and has an improved appearance.
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    Figure 3.13 Styling the ListResponses view

  


  Summary


  
    	
      ASP.NET Core projects are created with the dotnet new command.

    


    	
      Controllers define action methods that are used to handle HTTP requests.

    


    	
      Views generate HTML content that is used to respond to HTTP requests.

    


    	
      Views can contain HTML elements that are bound to data model properties.

    


    	
      Model binding is the process by which request data is parsed and assigned to the properties of objects that are passed to action methods for processing.

    


    	
      The data in the request can be subjected to validation and errors can be displayed to the user within the same HTML form that was used to submit the data.

    


    	
      The HTML content generated by views can be styled using the same CSS features that are applied to static HTML content.

    

  


  4 Using the development tools


  This chapter covers


  
    	Using command-line tools to create an ASP.NET Core project


    	Adding code and content to a project


    	Building and running an ASP.NET Core project


    	Using the hot reload feature


    	Installing NuGet packages


    	Installing tool packages


    	Installing client-side packages


    	Using the debugger

  


  In this chapter, I introduce the tools that Microsoft provides for ASP.NET Core development and that are used throughout this book.


  Unlike earlier editions of this book, I rely on the command-line tools provided by the .NET SDK and additional tool packages that Microsoft publishes. In part, I have done this to help ensure you get the expected results from the examples but also because the command-line tools provide access to all the features required for ASP.NET Core development, regardless of which editor/IDE you have chosen.


  Visual Studio—and, to a lesser extent, Visual Studio Code—offers access to some of the tools through user interfaces, which I describe in this chapter, but Visual Studio and Visual Studio Code don’t support all the features that are required for ASP.NET Core development, so there are times that using the command line is inevitable.


  As ASP.NET Core has evolved, I have gradually moved to using just the command-line tools, except for when I need to use a debugger (although, as I explain later in the chapter, this is a rare requirement). Your preferences may differ, especially if you are used to working entirely within an IDE, but my suggestion is to give the command-line tools a go. They are simple, concise, and predictable, which cannot be said for all the equivalent functionality provided by Visual Studio and Visual Studio Code. Table 4.1 provides a guide to the chapter.


  Table 4.1 Chapter guide


  
    
      
      
      
    

    
      
        	
          Problem

        

        	
          Solution

        

        	
          Listing

        
      

    

    
      
        	
          Creating a project

        

        	
          Use the dotnet new commands.

        

        	
          1–3

        
      


      
        	
          Building and running projects

        

        	
          Use the dotnet build and dotnet run commands.

        

        	
          4–10

        
      


      
        	
          Adding packages to a project

        

        	
          Use the dotnet add package command.

        

        	
          11, 12

        
      


      
        	
          Installing tool commands

        

        	
          Use the dotnet tool command.

        

        	
          14, 15

        
      


      
        	
          Managing client-side packages

        

        	
          Use the libman command or the Visual Studio client-side package manager.

        

        	
          16–19

        
      

    
  


  4.1 Creating ASP.NET Core projects


  The .NET SDK includes a set of command-line tools for creating, managing, building, and running projects. Visual Studio provides integrated support for some of these tasks, but if you are using Visual Studio Code, then the command line is the only option.


  I use the command-line tools throughout this book because they are simple and concise. The Visual Studio integrated support is awkward and makes it easy to unintentionally create a project with the wrong configuration, as the volume of emails from confused readers of earlier editions of this book has demonstrated.


  Tip You can download the example project for this chapter—and for all the other chapters in this book—from https://github.com/manningbooks/pro-asp.net-core-7. See chapter 1 for how to get help if you have problems running the examples.


  4.1.1 Creating a project using the command line


  The dotnet command provides access to the .NET command-line features. The dotnet new command is used to create a new project, configuration file, or solution file. To see the list of templates available for creating new items, open a PowerShell command prompt and run the command shown in listing 4.1.


  Listing 4.1 Listing the .NET templates

  dotnet new --list


  Each template has a short name that makes it easier to use. There are many templates available, but table 4.2 describes the ones that are most useful for creating ASP.NET Core projects.


  Table 4.2 Useful ASP.NET Core project templates


  
    
      
      
    

    
      
        	
          Name

        

        	
          Description

        
      

    

    
      
        	
          web

        

        	
          This template creates a project that is set up with the minimum code and content required for ASP.NET Core development. This is the template I use for most of the chapters in this book.

        
      


      
        	
          mvc

        

        	
          This template creates an ASP.NET Core project configured to use the MVC Framework.

        
      


      
        	
          webapp

        

        	
          This template creates an ASP.NET Core project configured to use Razor Pages.

        
      


      
        	
          blazorserver

        

        	
          This template creates an ASP.NET Core project configured to use Blazor Server.

        
      


      
        	
          angular

        

        	
          This template creates an ASP.NET Core project that contains client-side features using the Angular JavaScript framework.

        
      


      
        	
          react

        

        	
          This template creates an ASP.NET Core project that contains client-side features using the React JavaScript framework.

        
      


      
        	
          reactredux

        

        	
          This template creates an ASP.NET Core project that contains client-side features using the React JavaScript framework and the popular Redux library.

        
      

    
  


  There are also templates that create commonly required files used to configure projects, as described in table 4.3.


  
    Understanding the limitations of project templates


    The project templates described in table 4.2 are intended to help jump-start development by taking care of basic configuration settings and adding placeholder content.


    These templates can give you a sense of rapid progress, but they contain assumptions about how a project should be configured and developed. If you don’t understand the impact of those assumptions, you won’t be able to get the results you require for the specific demands of your project.


    The web template creates a project with the minimum configuration required for ASP.NET Core development. This is the project template I use for most of the examples in this book so that I can explain how each feature is configured and how the features can be used together.


    Once you understand how ASP.NET Core works, the other project templates can be useful because you will know how to adapt them to your needs. But, while you are learning, I recommend sticking to the web template, even though it can take a little more effort to get results.

  


  Table 4.3 The configuration item templates


  
    
      
      
    

    
      
        	
          Name

        

        	
          Description

        
      

    

    
      
        	
          globaljson

        

        	
          This template adds a global.json file to a project, specifying the version of .NET that will be used.

        
      


      
        	
          sln

        

        	
          This template creates a solution file, which is used to group multiple projects and is commonly used by Visual Studio. The solution file is populated with the dotnet sln add command, as shown in listing 4.2.

        
      


      
        	
          gitignore

        

        	
          This template creates a .gitignore file that excludes unwanted items from Git source control.

        
      

    
  


  To create a project, open a new PowerShell command prompt and run the commands shown in listing 4.2.


  Listing 4.2 Creating a new project

  dotnet new globaljson --sdk-version 7.0.100 --output MySolution/MyProject
dotnet new web --no-https --output MySolution/MyProject --framework net7.0
dotnet new sln -o MySolution
dotnet sln MySolution add MySolution/MyProject 


  The first command creates a MySolution/MyProject folder that contains a global.json file, which specifies that the project will use .NET version 7. The top-level folder, named MySolution, is used to group multiple projects. The nested MyProject folder will contain a single project.


  I use the globaljson template to help ensure you get the expected results when following the examples in this book. Microsoft is good at ensuring backward compatibility with .NET releases, but breaking changes do occur, and it is a good idea to add a global.json file to projects so that everyone in the development team is using the same version.


  The second command creates the project using the web template, which I use for most of the examples in this book. As noted in table 4.3, this template creates a project with the minimum content required for ASP.NET Core development. Each template has its own set of arguments that influence the project that is created. The --no-https argument creates a project without support for HTTPS. (I explain how to use HTTPS in chapter 16.) The --framework argument selects the .NET runtime that will be used for the project.


  The other commands create a solution file that references the new project. Solution files are a convenient way of opening multiple related files at the same time. A MySolution.sln file is created in the MySolution folder, and opening this file in Visual Studio will load the project created with the web template. This is not essential, but it stops Visual Studio from prompting you to create the file when you exit the code editor.


  Opening the project


  To open the project, start Visual Studio, select Open a Project or Solution, and open the MySolution.sln file in the MySolution folder. Visual Studio will open the solution file, discover the reference to the project that was added by the final command in listing 4.2, and open the project as well.


  Visual Studio Code works differently. Start Visual Studio Code, select File > Open Folder, and navigate to the MySolution folder. Click Select Folder, and Visual Studio Code will open the project.


  Although Visual Studio Code and Visual Studio are working with the same project, each displays the contents differently. Visual Studio Code shows you a simple list of files, ordered alphabetically, as shown on the left of figure 4.1. Visual Studio hides some files and nests others within related file items, as shown on the right of figure 4.1.
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    Figure 4.1 Opening a project in Visual Studio Code and Visual Studio

  


  There are buttons at the top of the Visual Studio Solution Explorer that disable file nesting and show the hidden items in the project. When you open a project for the first time in Visual Studio Code, you may be prompted to add assets for building and debugging the project. Click the Yes button.


  4.2 Adding code and content to projects


  If you are using Visual Studio Code, then you add items to the project by right-clicking the folder that should contain the file and selecting New File from the pop-up menu (or selecting New Folder if you are adding a folder).


  Note You are responsible for ensuring that the file extension matches the type of item you want to add; for example, an HTML file must be added with the .html extension. I give the complete file name and the name of the containing folder for every item added to a project throughout this book, so you will always know exactly what files you need to add.


  Right-click the My Project item in the list of files and select New Folder from the pop-up menu. Set the name to wwwroot, which is where static content is stored in ASP.NET Core projects. Press Enter, and a folder named wwwroot will be added to the project. Right-click the new wwwroot folder, select New File, and set the name to demo.html. Press Enter to create the HTML file and add the content shown in listing 4.3.


  Listing 4.3 The contents of the demo.html file in the wwwroot folder

  <!DOCTYPE html>
<html>
<head>
    <meta charset="utf-8" />
    <title></title>
</head>
<body>
    <h3>HTML File from MyProject</h3>
</body>
</html>


  Visual Studio provides a more comprehensive approach that can be helpful, but only when used selectively. To create a folder, right-click the MyProject item in the Solution Explorer and select Add > New Folder from the pop-up menu. Set the name of the new item to wwwroot and press Enter; Visual Studio will create the folder.


  Right-click the new wwwroot item in the Solution Explorer and select Add > New Item from the pop-up menu. Visual Studio will present you with an extensive selection of templates for adding items to the project. These templates can be searched using the text field in the top-right corner of the window or filtered using the categories on the left of the window. The item template for an HTML file is named HTML Page, as shown in figure 4.2.
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    Figure 4.2 Adding an item to the example project

  


  Enter demo.html in the Name field, click the Add button to create the new file, and replace the contents with the element shown in listing 4.3. (If you omit the file extension, Visual Studio will add it for you based on the item template you have selected. If you entered just demo into the Name field when you created the file, Visual Studio would have created a file with the .html extension because you had selected the HTML Page item template.)


  4.2.1 Understanding item scaffolding


  The item templates presented by Visual Studio can be useful, especially for C# classes where it sets the namespace and class name automatically. But Visual Studio also provides scaffolded items, which I recommend against using. The Add > New Scaffolded Item leads to a selection of items that guide you through a process to add more complex items. Visual Studio will also offer individual scaffolded items based on the name of the folder that you are adding an item to. For example, if you right-click a folder named Views, Visual Studio will helpfully add scaffolded items to the top of the menu, as shown in figure 4.3.
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    Figure 4.3 Scaffolded items in the Add menu

  


  The View and Controller items are scaffolded, and selecting them will present you with choices that determine the content of the items you create.


  Just like the project templates, I recommend against using scaffolded items, at least until you understand the content they create. In this book, I use only the Add > New Item menu for the examples and change the placeholder content immediately.


  4.3 Building and running projects


  The simplest way to build and run a project is to use the command-line tools. To prepare, add the statement shown in listing 4.4 to the Program.cs class file in the MyProject folder.


  Listing 4.4 Adding a statement in the Program.cs file in the MyProject folder

  var builder = WebApplication.CreateBuilder(args);
var app = builder.Build();

app.MapGet("/", () => "Hello World!");

app.UseStaticFiles();

app.Run();


  This statement adds support for responding to HTTP requests with static content in the wwwroot folder, such as the HTML file created in the previous section. (I explain this feature in more detail in chapter 15.)


  Next, set the HTTP port that ASP.NET Core will use to receive HTTP requests, as shown in listing 4.5.


  Listing 4.5 Setting the HTTP port in the launchSettings.json file in the Properties folder

  {
  "iisSettings": {
    "windowsAuthentication": false,
    "anonymousAuthentication": true,
    "iisExpress": {
      "applicationUrl": "http://localhost:5000",
      "sslPort": 0
    }
  },
  "profiles": {
    "MyProject": {
      "commandName": "Project",
      "dotnetRunMessages": true,
      "launchBrowser": true,
      "applicationUrl": "http://localhost:5000",
      "environmentVariables": {
        "ASPNETCORE_ENVIRONMENT": "Development"
      }
    },
    "IIS Express": {
      "commandName": "IISExpress",
      "launchBrowser": true,
      "environmentVariables": {
        "ASPNETCORE_ENVIRONMENT": "Development"
      }
    }
  }
}


  To build the example project, run the command shown in listing 4.6 in the MyProject folder.


  Listing 4.6 Building the project

  dotnet build


  You can build and run the project in a single step by running the command shown in listing 4.7 in the MyProject folder.


  Listing 4.7 Building and running the project

  dotnet run


  The compiler will build the project and then start the integrated ASP.NET Core HTTP server to listen for HTTP requests on port 5000. You can see the contents of the static HTML file added to the project earlier in the chapter by opening a new browser window and requesting http://localhost:5000/demo.html, which produces the response shown in figure 4.4.
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    Figure 4.4 Running the example application

  


  4.3.1 Using the hot reload feature


  .NET has an integrated hot reload feature, which compiles and applies updates to applications on the fly. For ASP.NET Core applications, this means that changes to the project are automatically reflected in the browser without having to manually stop the ASP.NET Core application and use the dotnet run command. Use Control+C to stop ASP.NET Core if the application is still running from the previous section and run the command shown in listing 4.8 in the MyProject folder.


  Listing 4.8 Starting the application with hot reload

  dotnet watch


  The dotnet watch command opens a new browser window, which it does to ensure that the browser loads a small piece of JavaScript that opens an HTTP connection to the server that is used to handle reloading. (The new browser window can be disabled by setting the launchBrowser property shown in listing 4.5 to false, but you will have to perform a manual reload the first time you start or restart ASP.NET Core.) Use the browser to request http://localhost:5000/demo.html, and you will see the output shown on the left of figure 4.5.


  The dotnet watch command monitors the project for changes. When a change is detected, the project is automatically recompiled, and the browser is reloaded. To see this process in action, make the change shown in listing 4.9 to the demo.html file in the wwwroot folder.


  Listing 4.9 Changing the message in the demo.html file in the wwwroot folder

  <!DOCTYPE html>
<html>
<head>
    <meta charset="utf-8" />
    <title></title>
</head>
<body>
    <h3>New Message</h3>
</body>
</html>


  When you save the changes to the HTML file, the dotnet watch tool will detect the change and automatically update the browser, as shown in figure 4.5.
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    Figure 4.5 The hot reload feature

  


  The dotnet watch command is a clever feat of engineering, and it has good support for ASP.NET Core applications, allowing changes to be easily applied. But not all changes can be handled with a hot reload.


  If you are using Visual Studio, right-click the MyProject item in the Solution Explorer, select Add > Class from the pop-up menu, and set the name of the new class file to MyClass.cs. When Visual Studio opens the file for editing, change the namespace as shown in listing 4.10.


  Listing 4.10 Changing a namespace in the MyClass.cs file in the MyProject folder

  namespace MyProject.MyNamespace {
    public class MyClass {
    }
}


  If you are using Visual Studio Code, add a file named MyClass.cs to the MyProject folder with the content shown in listing 4.10.


  Regardless of which editor you use, you will see output similar to the following when you save the class file:

  watch : File changed: C:\MySolution\MyProject\MyClass.cs.
watch : Unable to apply hot reload because of a rude edit.


  There are some changes that the dotnet watch command can’t handle with a hot reload and the application is restarted instead. You may be prompted to accept the restart. The restart has little effect on the example application, but it means that the application state is lost, which can be frustrating when working on real projects.


  But even though it isn’t perfect, the hot reload feature is useful, especially when it comes to iterative adjustments to the HTML an application produces. I don’t use it in most of the chapters in this book because the examples require many changes that are not handled with hot reloads and that can prevent changes from taking effect, but I do use it for my own non-book related development projects.


  4.4 Managing packages


  Most projects require additional features beyond those set up by the project templates, such as support for accessing databases or for making HTTP requests, neither of which is included in the standard ASP.NET Core packages added to the project by the template used to create the example project. In the sections that follow, I describe the tools available to manage the different types of packages that are used in ASP.NET Core development.


  4.4.1 Managing NuGet packages


  .NET packages are added to a project with the dotnet add package command. Use a PowerShell command prompt to run the command shown in listing 4.11 in the MyProject folder to add a package to the example project.


  Listing 4.11 Adding a package to the example project

  dotnet add package Microsoft.EntityFrameworkCore.SqlServer --version 7.0.0


  This command installs version 7.0.0 of the Microsoft.EntityFrameworkCore.SqlServer package. The package repository for .NET projects is nuget.org, where you can search for the package and see the versions available. The package installed in listing 4.11, for example, is described at https://www.nuget.org/packages/Microsoft.EntityFrameworkCore.SqlServer/7.0.0. You can see the packages installed in a project by running the command shown in listing 4.12.


  Tip The project file—which is the file with the .csproj extension—is used to keep track of the packages added to a project. You can examine this file by opening it for editing in Visual Studio Code or by right-clicking the project item in the Visual Studio Solution Explorer and selecting Edit Project File from the pop-up menu.


  Listing 4.12 Listing the packages in a project

  dotnet list package 


  This command produces the following output when it is run in the MyProject folder, showing the package added in listing 4.11:

  Project 'MyProject' has the following package references
   [net7.0]:
   Top-level Package                              Requested   Resolved
   > Microsoft.EntityFrameworkCore.SqlServer      7.0.0       7.0.0


  Packages are removed with the dotnet remove package command. To remove the package from the example project, run the command shown in listing 4.13 in the MyProject folder.


  Listing 4.13 Removing a package from the example project

  dotnet remove package Microsoft.EntityFrameworkCore.SqlServer


  4.4.2 Managing tool packages


  Tool packages install commands that can be used from the command line to perform operations on .NET projects. One common example is the Entity Framework Core tools package that installs commands that are used to manage databases in ASP.NET Core projects. Tool packages are managed using the dotnet tool command. To install the Entity Framework Core tools package, run the commands shown in listing 4.14.


  Listing 4.14 Installing a tool package

  dotnet tool uninstall --global dotnet-ef
dotnet tool install --global dotnet-ef --version 7.0.0


  The first command removes the dotnet-ef package, which is named dotnet-ef. This command will produce an error if the package has not already been installed, but it is a good idea to remove existing versions before installing a package. The dotnet tool install command installs version 7.0.0 of the dotnet-ef package, which is the version I use in this book. The commands installed by tool packages are used through the dotnet command. To test the package installed in listing 4.14, run the command shown in listing 4.15 in the MyProject folder.


  Tip The --global arguments in listing 4.14 mean the package is installed for global use and not just for a specific project. You can install tool packages into just one project, in which case the command is accessed with dotnet tool run <command>. The tools I use in this book are all installed globally.


  Listing 4.15 Running a tool package command

  dotnet ef --help


  The commands added by this tool package are accessed using dotnet ef, and you will see examples in later chapters that rely on these commands.


  4.4.3 Managing client-side packages


  Client-side packages contain content that is delivered to the client, such as images, CSS stylesheets, JavaScript files, and static HTML. Client-side packages are added to ASP.NET Core using the Library Manager (LibMan) tool. To install the LibMan tool package, run the commands shown in listing 4.16.


  Listing 4.16 Installing the LibMan tool package

  dotnet tool uninstall --global Microsoft.Web.LibraryManager.Cli
dotnet tool install --global Microsoft.Web.LibraryManager.Cli --version 2.1.175


  These commands remove any existing LibMan package and install the version that is used throughout this book. The next step is to initialize the project, which creates the file that LibMan uses to keep track of the client packages it installs. Run the command shown in listing 4.17 in the MyProject folder to initialize the example project.


  Listing 4.17 Initializing the example project

  libman init -p cdnjs


  LibMan can download packages from different repositories. The -p argument in listing 4.17 specifies the repository at https://cdnjs.com, which is the most widely used. Once the project is initialized, client-side packages can be installed. To install the Bootstrap CSS framework that I use to style HTML content throughout this book, run the command shown in listing 4.18 in the MyProject folder.


  Listing 4.18 Installing the Bootstrap CSS framework

  libman install bootstrap@5.2.3 -d wwwroot/lib/bootstrap


  The command installs version 5.2.3 of the Bootstrap package, which is known by the name bootstrap on the CDNJS repository. The -d argument specifies the location into which the package is installed. The convention in ASP.NET Core projects is to install client-side packages into the wwwroot/lib folder.


  Once the package has been installed, add the classes shown in listing 4.19 to the elements in the demo.html file. This is how the features provided by the Bootstrap package are applied.


  Note I don’t get into the details of using the Bootstrap CSS framework in this book. See https://getbootstrap.com for the Bootstrap documentation.


  Listing 4.19 Applying Bootstrap classes in the demo.html file in the wwwroot folder

  <!DOCTYPE html>
<html>
<head>
    <meta charset="utf-8" />
    <title></title>
    <link href="/lib/bootstrap/css/bootstrap.min.css" rel="stylesheet" />
</head>
<body>
    <h3 class="bg-primary text-white text-center p-2">New Message</h3>
</body>
</html>


  Start ASP.NET Core and request http://localhost:5000/demo.html, and you will see the styled content shown in figure 4.6.
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    Figure 4.6 Using a client-side package

  


  4.5 Debugging projects


  Visual Studio and Visual Studio Code both provide debuggers that can be used to control and inspect the execution of an ASP.NET Core application. Open the Program.cs file in the MyProject folder, and click this statement in the code editor:

  ...
app.MapGet("/", () => "Hello World!");
...


  Select Debug > Toggle Breakpoint in Visual Studio or select Run > Toggle Breakpoint in Visual Studio Code. A breakpoint is shown as a red dot alongside the code statement, as shown in figure 4.7, and will interrupt execution and pass control to the user.
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    Figure 4.7 Setting a breakpoint

  


  Start the project by selecting Debug > Start Debugging in Visual Studio or selecting Run > Start Debugging in Visual Studio Code. (Choose .NET if Visual Studio Code prompts you to select an environment and then select the Start Debugging menu item again.)


  The application will be started and continue normally until the statement to which the breakpoint is reached, at which point execution is halted. Execution can be controlled using the Debug or Run menu or the controls that Visual Studio and Visual Studio Code display. Both debuggers are packed with features—more so if you have a paid-for version of Visual Studio—and I don’t describe them in depth in this book. The Visual Studio debugger is described at https://docs.microsoft.com/en-us/visualstudio/debugger, and the Visual Studio Code debugger is described at https://code.visualstudio.com/docs/editor/debugging.


  
    How I debug my code


    Debuggers are powerful tools, but I rarely use them. In most situations, I prefer to add Console.WriteLine statements to my code to figure out what is going on, which I can easily do because I use the dotnet run command to run my projects from the command line. This is a rudimentary approach that works for me, not least because most of the errors in my code tend to be where statements are not being called because a condition in an if statement isn’t effective. If I want to examine an object in detail, I tend to serialize it to JSON and pass the result to the WriteLine method.


    This may seem like madness if you are a dedicated user of the debugger, but it has the advantage of being quick and simple. When I am trying to figure out why code isn’t working, I want to explore and iterate quickly, and I find the amount of time taken to start the debugger to be a barrier. My approach is also reliable. The Visual Studio and Visual Studio Code debuggers are sophisticated, but they are not always entirely predictable, and .NET and ASP.NET Core change too quickly for the debugger features to have entirely settled down. When I am utterly confused by the behavior of some code, I want the simplest possible diagnostic tool, and that, for me, is a message written to the console.


    I am not suggesting that this is the approach you should use, but it can be a good place to start when you are not getting the results you expect and you don’t want to battle with the debugger to figure out why.

  


  Summary


  
    	
      ASP.NET Core projects are created with the dotnet new command.

    


    	
      There are templates to jumpstart popular project types and to create common project items.

    


    	
      The dotnet build command compiles a project.

    


    	
      The dotnet run command builds and executes a project.

    


    	
      The dotnet watch command builds and executes a project, and performs hot reloading when changes are detected.

    


    	
      Packages are added to a project with the dotnet add package command.

    


    	
      Tool packages are installing using the dotnet tool install command.

    


    	
      Client-side packages are managed with the libman tool package.

    

  


  
5 Essential C# features


  This chapter covers


  
    	Using C# language features for ASP.NET Core development


    	Dealing with null values and the null state analysis feature


    	Creating objects concisely


    	Adding features to classes without directly modifying them


    	Expressing functions concisely


    	Modifying interfaces without breaking implementation classes


    	Defining asynchronous methods

  


  In this chapter, I describe C# features used in web application development that are not widely understood or that often cause confusion. This is not a book about C#, however, so I provide only a brief example for each feature so that you can follow the examples in the rest of the book and take advantage of these features in your projects. Table 5.1 provides a guide to this chapter.


  Table 5.1 Chapter guide


  
    
      
      
      
    

    
      
        	
          Problem

        

        	
          Solution

        

        	
          Listing

        
      

    

    
      
        	
          Reducing duplication in using statements

        

        	
          Use global or implicit using statements.

        

        	
          8–10

        
      


      
        	
          Managing null values

        

        	
          Use nullable and non-nullable types, which are managed with the null management operators.

        

        	
          11–20

        
      


      
        	
          Mixing static and dynamic values in strings

        

        	
          Use string interpolation.

        

        	
          21

        
      


      
        	
          Initializing and populate objects

        

        	
          Use the object and collection initializers and target-typed new expressions.

        

        	
          22–26

        
      


      
        	
          Assigning a value for specific types

        

        	
          Use pattern matching.

        

        	
          27, 28

        
      


      
        	
          Extending the functionality of a class without modifying it

        

        	
          Define an extension method.

        

        	
          29–36

        
      


      
        	
          Expressing functions and methods concisely

        

        	
          Use lambda expressions.

        

        	
          37–44

        
      


      
        	
          Defining a variable without explicitly declaring its type

        

        	
          Use the var keyword.

        

        	
          45–47

        
      


      
        	
          Modifying an interface without requiring changes in its implementation classes

        

        	
          Define a default implementation.

        

        	
          48–52

        
      


      
        	
          Performing work asynchronously

        

        	
          Use tasks or the async/await keywords.

        

        	
          53–55

        
      


      
        	
          Producing a sequence of values over time

        

        	
          Use an asynchronous enumerable.

        

        	
          56–59

        
      


      
        	
          Getting the name of a class or member

        

        	
          Use a nameof expression.

        

        	
          60, 61

        
      

    
  


  5.1 Preparing for this chapter


  To create the example project for this chapter, open a new PowerShell command prompt and run the commands shown in listing 5.1. If you are using Visual Studio and prefer not to use the command line, you can create the project using the process described in chapter 4.


  Tip You can download the example project for this chapter—and for all the other chapters in this book—from https://github.com/manningbooks/pro-asp.net-core-7. See chapter 1 for how to get help if you have problems running the examples.


  Listing 5.1 Creating the example project

  dotnet new globaljson --sdk-version 7.0.100 --output LanguageFeatures
dotnet new web --no-https --output LanguageFeatures --framework net7.0
dotnet new sln -o LanguageFeatures
dotnet sln LanguageFeatures add LanguageFeatures


  5.1.1 Opening the project


  If you are using Visual Studio, select File > Open > Project/Solution, select the LanguageFeatures.sln file in the LanguageFeatures folder, and click the Open button to open the solution file and the project it references. If you are using Visual Studio Code, select File > Open Folder, navigate to the LanguageFeatures folder, and click the Select Folder button.


  5.1.2 Enabling the MVC Framework


  The web project template creates a project that contains a minimal ASP.NET Core configuration. This means the placeholder content that is added by the mvc template used in chapter 3 is not available and that extra steps are required to reach the point where the application can produce useful output. In this section, I make the changes required to set up the MVC Framework, which is one of the application frameworks supported by ASP.NET Core, as I explained in chapter 1. First, to enable the MVC framework, make the changes shown in listing 5.2 to the Program.cs file.


  Listing 5.2 Enabling MVC in the Program.cs file in the LanguageFeatures folder

  var builder = WebApplication.CreateBuilder(args);

builder.Services.AddControllersWithViews();

var app = builder.Build();

//app.MapGet("/", () => "Hello World!");
app.MapDefaultControllerRoute();

app.Run();


  I explain how to configure ASP.NET Core applications in part 2, but the two statements added in listing 5.2 provide a basic MVC framework setup using a default configuration.


  5.1.3 Creating the application components


  Now that the MVC framework is set up, I can add the application components that I will use to demonstrate important C# language features. As you create these components, you will see that the code editor underlines some expressions to warn you of potential problems. These are safe to ignore until the “Understanding Null State Analysis” section, where I explain their significance.


  Creating the data model


  I started by creating a simple model class so that I can have some data to work with. I added a folder called Models and created a class file called Product.cs within it, which I used to define the class shown in listing 5.3.


  Listing 5.3 The contents of the Product.cs file in the Models folder

  namespace LanguageFeatures.Models {
    public class Product {
 
        public string Name { get; set; }
        public decimal? Price { get; set; }
 
        public static Product[] GetProducts() {
 
            Product kayak = new Product { 
                Name = "Kayak", Price = 275M 
            };
 
            Product lifejacket = new Product { 
                Name = "Lifejacket", Price = 48.95M 
            };
 
            return new Product[] { kayak, lifejacket, null };
        }
    }
}


  The Product class defines Name and Price properties, and there is a static method called GetProducts that returns a Product array. One of the elements contained in the array returned by the GetProducts method is set to null, which I will use to demonstrate some useful language features later in the chapter.


  The Visual Studio and Visual Studio Code editors will highlight a problem with the Name property. This is a deliberate error that I explain later in the chapter and which should be ignored for now.


  Creating the controller and view


  For the examples in this chapter, I use a simple controller class to demonstrate different language features. I created a Controllers folder and added to it a class file called HomeController.cs, the contents of which are shown in listing 5.4.


  Listing 5.4 The contents of the HomeController.cs file in the Controllers folder

  using Microsoft.AspNetCore.Mvc;

namespace LanguageFeatures.Controllers {
    public class HomeController : Controller {
 
        public ViewResult Index() {
            return View(new string[] { "C#", "Language", "Features" });
        }
    }
}


  The Index action method tells ASP.NET Core to render the default view and provides it with an array of strings as its view model, which will be included in the HTML sent to the client. To create the view, I added a Views/Home folder (by creating a Views folder and then adding a Home folder within it) and added a Razor View called Index.cshtml, the contents of which are shown in listing 5.5.


  Listing 5.5 The contents of the Index.cshtml file in the Views/Home folder

  @model IEnumerable<string>
@{ Layout = null; }

<!DOCTYPE html>
<html>
<head>
    <meta name="viewport" content="width=device-width" />
    <title>Language Features</title>
</head>
<body>
    <ul>
        @foreach (string s in Model) {
            <li>@s</li>
        }
    </ul>
</body>
</html>


  The code editor will highlight part of this file to denote a warning, which I explain shortly.


  5.1.4 Selecting the HTTP port


  Change the HTTP port that ASP.NET Core uses to receive requests, as shown in listing 5.6.


  Listing 5.6 Setting the HTTP port in the launchSettings.json file in the Properties folder

  {
  "iisSettings": {
    "windowsAuthentication": false,
    "anonymousAuthentication": true,
    "iisExpress": {
      "applicationUrl": "http://localhost:5000",
      "sslPort": 0
    }
  },
  "profiles": {
    "LanguageFeatures": {
      "commandName": "Project",
      "dotnetRunMessages": true,
      "launchBrowser": true,
      "applicationUrl": "http://localhost:5000",
      "environmentVariables": {
        "ASPNETCORE_ENVIRONMENT": "Development"
      }
    },
    "IIS Express": {
      "commandName": "IISExpress",
      "launchBrowser": true,
      "environmentVariables": {
        "ASPNETCORE_ENVIRONMENT": "Development"
      }
    }
  }
}


  5.1.5 Running the example application


  Start ASP.NET Core by running the command shown in listing 5.7 in the LanguageFeatures folder.


  Listing 5.7 Running the example application

  dotnet run


  The output from the dotnet run command will include two build warnings, which I explain in the “Understanding Null State Analysis” section. Once ASP.NET Core has started, use a web browser to request http://localhost:5000, and you will see the output shown in figure 5.1.
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    Figure 5.1 Running the example application

  


  Since the output from all the examples in this chapter is text, I will show the messages displayed by the browser like this:

  C# 
Language 
Features


  5.2 Understanding top-level statements


  Top-level statements are intended to remove unnecessary code structure from class files. A project can contain one file that defines code statements outside of a namespace or a file. For ASP.NET Core applications, this feature is used to configure the application in the Program.cs file. Here is the content of the Program.cs file in the example application for this chapter:

  var builder = WebApplication.CreateBuilder(args);

builder.Services.AddControllersWithViews();

var app = builder.Build();

//app.MapGet("/", () => "Hello World!");

app.MapDefaultControllerRoute();

app.Run();


  If you have used earlier versions of ASP.NET Core, you will be familiar with the Startup class, which was used to configure the application. Top-level statements have allowed this process to be simplified, and all of the configuration statements are now defined in the Program.cs file.


  The compiler will report an error if there is more than one file in a project with top-level statements, so the Program.cs file is the only place you will find them in an ASP.NET Core project.


  5.3 Understanding global using statements


  C# supports global using statements, which allow a using statement to be defined once but take effect throughout a project. Traditionally, each code file contains a series of using statements that declare dependencies on the namespaces that it requires. Listing 5.8 adds a using statement that provides access to the types defined in the Models namespace. (The code editor will highlight part of this code listing, which I explain in the “Understanding Null State Analysis” section.)


  Listing 5.8 Adding a statement in the HomeController.cs file in the Controllers folder

  using Microsoft.AspNetCore.Mvc;
using LanguageFeatures.Models;

namespace LanguageFeatures.Controllers {
    public class HomeController : Controller {
        
        public ViewResult Index() {
            Product[] products = Product.GetProducts();
            return View(new string[] { products[0].Name });
        }
    }
}


  To access the Product class, I added a using statement for the namespace that contains it, which is LanguageFeatures.Models. The code file already contains a using statement for the Microsoft.AspNetCore.Mvc namespace, which provides access to the Controller class, from which the HomeController class is derived.


  In most projects, some namespaces are required throughout the application, such as those containing data model classes. This can result in a long list of using statements, duplicated in every code file. Global using statements address this problem by allowing using statements for commonly required namespaces to be defined in a single location. Add a code file named GlobalUsings.cs to the LanguageFeatures project with the content shown in listing 5.9.


  Listing 5.9 The contents of the GlobalUsings.cs file in the LanguageFeatures folder

  global using LanguageFeatures.Models;
global using Microsoft.AspNetCore.Mvc;


  The global keyword is used to denote a global using. The statements in listing 5.9 make the LanguageFeatures.Models and Microsoft.AspNetCore.Mvc namespaces available throughout the application, which means they can be removed from the HomeController.cs file, as shown in listing 5.10.


  Listing 5.10 Removing statements in the HomeController.cs file in the Controllers folder

  //using Microsoft.AspNetCore.Mvc;
//using LanguageFeatures.Models;

namespace LanguageFeatures.Controllers {
    public class HomeController : Controller {
        
        public ViewResult Index() {
            Product[] products = Product.GetProducts();
            return View(new string[] { products[0].Name });
        }
    }
}


  If you run the example, you will see the following results displayed in the browser window:

  Kayak


  You will receive warnings when compiling the project, which I explain in the “Understanding Null State Analysis” section.


  Note Global using statements are a good idea, but I have not used them in this book because I want to make it obvious when I add a dependency to a new namespace.


  5.3.1 Understanding implicit using statements


  The ASP.NET Core project templates enable a feature named implicit usings, which define global using statements for these commonly required namespaces:


  
    	
      System

    


    	
      System.Collections.Generic

    


    	
      System.IO

    


    	
      System.Linq

    


    	
      System.Net.Http

    


    	
      System.Net.Http.Json

    


    	
      System.Threading

    


    	
      System.Threading.Tasks

    


    	
      Microsoft.AspNetCore.Builder

    


    	
      Microsoft.AspNetCore.Hosting

    


    	
      Microsoft.AspNetCore.Http

    


    	
      Microsoft.AspNetCore.Routing

    


    	
      Microsoft.Extensions.Configuration

    


    	
      Microsoft.Extensions.DependencyInjection

    


    	
      Microsoft.Extensions.Hosting

    


    	
      Microsoft.Extensions.Logging

    

  


  using statements are not required for these namespaces, which are available throughout the application. These namespaces don’t cover all of the ASP.NET Core features, but they do cover the basics, which is why no explicit using statements are required in the Program.cs file.


  5.4 Understanding null state analysis


  The editor and compiler warnings shown in earlier sections are produced because ASP.NET Core project templates enable null state analysis, in which the compiler identifies attempts to access references that may be unintentionally null, preventing null reference exceptions at runtime.


  Open the Product.cs file, and the editor will display two warnings, as shown in figure 5.2. The figure shows how Visual Studio displays a warning, but Visual Studio Code is similar.
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    Figure 5.2 A null state analysis warning

  


  When null state analysis is enabled, C# variables are divided into two groups: nullable and non-nullable. As their name suggests, nullable variables can be assigned the special value null. This is the behavior that most programmers are familiar with, and it is entirely up to the developer to guard against trying to use null references, which will trigger a NullReferenceException.


  By contrast, non-nullable variables can never be null. When you receive a non-nullable variable, you don’t have to guard against a null value because that is not a value that can ever be assigned.


  A question mark (the ? character) is appended to a type to denote a nullable type. So, if a variable’s type is string?, for example, then it can be assigned any value string value or null. When attempting to access this variable, you should check to ensure that it isn’t null before attempting to access any of the fields, properties, or methods defined by the string type.


  If a variable’s type is string, then it cannot be assigned null values, which means you can confidently access the features it provides without needing to guard against null references.


  The compiler examines the code in the project and warns you when it finds statements that might break these rules. The most common issues are attempting to assign null to non-nullable variables and attempting to access members defined by nullable variables without checking to see if they are null. In the sections that follow, I explain the different ways that the warnings raised by the compiler in the example application can be addressed.


  Note Getting to grips with nullable and non-nullable types can be frustrating. A change in one code file can simply move a warning to another part of the application, and it can feel like you are chasing problems through a project. But it is worth sticking with null state analysis because null reference exceptions are the most common runtime error, and few programmers are disciplined enough to guard against null values without the compiler analysis feature.


  5.4.1 Ensuring fields and properties are assigned values


  The first warning in the Product.cs file is for the Name field, whose type is string, which is a non-nullable type (because it hasn’t been annotated with a question mark).

  ...
public string Name { get; set; }
...


  One consequence of using non-nullable types is that properties like Name must be assigned a value when a new instance of the enclosing class is created. If this were not the case, then the Name property would not be initialized and would be null. And this is a problem because we can’t assign null to a non-nullable property, even indirectly.


  The required keyword can be used to indicate that a value is required for a non-nullable type, as shown in listing 5.11.


  Listing 5.11 Using the required keyword in the Product.cs file in the Models folder

  namespace LanguageFeatures.Models {
    public class Product {
        
        public required string Name { get; set; }
        public decimal? Price { get; set; }
                
        public static Product[] GetProducts() {
                
            Product kayak = new Product {
                Name = "Kayak", Price = 275M
            };
                        
            Product lifejacket = new Product {
                Name = "Lifejacket", Price = 48.95M
            };
                        
            return new Product[] { kayak, lifejacket, null };
        }
    }
}


  The compiler will check to make sure that a value is assigned to the property when a new instance of the containing type is created. The two Product objects used in the listing are created with a value for the Name field, which satisfies the demands of the required keyword. Listing 5.12 omits the Name value from one of Product objects.


  Listing 5.12 Omitting a value in the Product.cs file in the Models folder

  namespace LanguageFeatures.Models {
    public class Product {
        
        public required string Name { get; set; }
        public decimal? Price { get; set; }
                
        public static Product[] GetProducts() {
                
            Product kayak = new Product {
                Name = "Kayak", Price = 275M
            };
                        
            Product lifejacket = new Product {
                //Name = "Lifejacket", 
                Price = 48.95M
            };
                        
            return new Product[] { kayak, lifejacket, null };
        }
    }
}


  If you run the example, the build process will fail with this error:

  Required member 'Product.Name' must be set in the object initializer or attribute constructor.


  This error—and the corresponding red line in the code editor—tell you that a value for the Name property is required but has not been provided.


  5.4.2 Providing a default value for non-nullable types


  The required keyword is a good way to denote a property that cannot be null, and which requires a value when an object is created. This approach can become cumbersome in situations where there may not always be a suitable data value available, because it requires the code wants to create the object to provide a fallback value and there is no good way to enforce consistency.


  For these situations a default value can be used instead of the required keyword, as shown in listing 5.13.


  Listing 5.13 Providing a default value in the Product.cs file in the Models folder

  namespace LanguageFeatures.Models {
    public class Product {
        
        public string Name { get; set; } = string.Empty;
        public decimal? Price { get; set; }
                
        public static Product[] GetProducts() {
                
            Product kayak = new Product {
                Name = "Kayak", Price = 275M
            };
                        
            Product lifejacket = new Product {
                //Name = "Lifejacket", 
                Price = 48.95M
            };
                        
            return new Product[] { kayak, lifejacket, null };
        }
    }
}


  The default value in this example is the empty string. This value will be replaced for Product objects that are created with a Name value and ensures consistency for objects that are created without one.


  5.4.3 Using nullable types


  The remaining warning in the Product.cs file occurs because there is a mismatch between the type used for the result of the GetProducts method and the values that are used to initialize it:

  ...
return new Product[] { kayak, lifejacket, null };
...


  The type of the array that is created is Product[], which contains non-nullable Product references. But one of the values used to populate the array is null, which isn’t allowed. Listing 5.14 changes the array type so that nullable values are allowed.


  Listing 5.14 Using a nullable type in the Product.cs file in the Models folder

  namespace LanguageFeatures.Models {
    public class Product {
        
        public string Name { get; set; } = string.Empty;
        public decimal? Price { get; set; }
                
        public static Product?[] GetProducts() {
                
            Product kayak = new Product {
                Name = "Kayak", Price = 275M
            };
                        
            Product lifejacket = new Product {
                //Name = "Lifejacket", 
                Price = 48.95M
            };
                        
            return new Product?[] { kayak, lifejacket, null };
        }
    }
}


  The type Product?[] denotes an array of Product? references, which means the result can include null. Notice that I had to make the same change to the result type declared by the GetProducts method because a Product?[] array cannot be used where a Product[] is expected.


  
    Selecting the right nullable type


    Care must be taken to apply the question mark correctly, especially when dealing with arrays and collections. A variable of type Product?[] denotes an array that can contain Product or null values but that won’t be null itself:

    ...
Product?[] arr1 = new Product?[] { kayak, lifejacket, null };  // OK
Product?[] arr2 = null;                                        // Not OK
...


    A variable of type Product[]? is an array that can hold only Product values and not null values, but the array itself may be null:

    ...
Product[]? arr1 = new Product?[] { kayak, lifejacket, null }; // Not OK
Product[]? arr2 = null;                                       // OK
...


    A variable of type Product?[]? is an array that can contain Product or null values and that can itself be null:

    ...
Product?[]? arr1 = new Product?[] { kayak, lifejacket, null }; // OK
Product?[]? arr2 = null;                                          // Also OK
...


    Null state analysis is a useful feature, but that doesn’t mean it is always easy to understand.

  


  5.4.4 Checking for null values


  I explained that dealing with null state analysis warnings can feel like chasing a problem through code, and you can see a simple example of this in the HomeController.cs file in the Controllers folder. In listing 5.14, I changed the type returned by the GetProducts method to allow null values, but that has created a mismatch in the HomeController class, which invokes that method and assigns the result to an array of non-nullable Product values:

  ...
Product[] products = Product.GetProducts();
...


  This is easily resolved by changing the type of the products variable to match the type returned by the GetProducts method, as shown in listing 5.15.


  Listing 5.15 Changing Type in the HomeController.cs File in the Controllers Folder

  namespace LanguageFeatures.Controllers {
    public class HomeController : Controller {
        
        public ViewResult Index() {
            Product?[] products = Product.GetProducts();
            return View(new string[] { products[0].Name });
        }
    }
}


  This resolves one warning and introduces another, as shown in figure 5.3.
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    Figure 5.3 An additional null state analysis warning

  


  The statement flagged by the compiler attempts to access the Name field of the element at index zero in the array, which might be null since the array type is Product?[]. Addressing this issue requires a check for null values, as shown in listing 5.16.


  Listing 5.16 Guarding against null in the HomeController.cs file in the Controllers folder

  namespace LanguageFeatures.Controllers {
    public class HomeController : Controller {
        
        public ViewResult Index() {
            Product?[] products = Product.GetProducts();
            Product? p = products[0];
            string val;
            if (p != null) {
                val = p.Name;
            } else {
                val = "No value";
            }
            return View(new string[] { val });
        }
    }
}


  This is an especially verbose way of avoiding a null, which I will refine shortly. But it demonstrates an important point, which is that the compiler can understand the effect of C# expressions when checking for a null reference. In listing 5.16, I use an if statement to see if a Product? variable is not null, and the compiler understands that the variable cannot be null within the scope of the if clause and doesn’t generate a warning when I read the name field:

  ...
if (p != null) {
    val = p.Name;
} else {
    val = "No value";
}
...


  The compiler has a sophisticated understanding of C# but doesn’t always get it right, and I explain what to do when the compiler isn’t able to accurately determine whether a variable is null in the “Overriding Null State Analysis” section.


  Using the null conditional operator


  The null conditional operator is a more concise way of avoiding member access for null values, as shown in listing 5.17.


  Listing 5.17 Null conditional operator in the HomeController.cs file in the Controllers folder

  namespace LanguageFeatures.Controllers {
    public class HomeController : Controller {
        
        public ViewResult Index() {
                
            Product?[] products = Product.GetProducts();
                        
            string? val = products[0]?.Name;
            if (val != null) {
                return View(new string[] { val });
            }
            return View(new string[] { "No Value" });
        }
    }
}


  The null conditional operator is a question mark applied before a member is accessed, like this:

  ...
string? val = products[0]?.Name;
...


  The operator returns null if it is applied to a variable that is null. In this case, if the element at index zero of the products array is null, then the operator will return null and prevent an attempt to access the Name property, which would cause an exception. If products[0] isn’t null, then the operator does nothing, and the expression returns the value assigned to the Name property. Applying the null conditional operator can return null, and its result must always be assigned to a nullable variable, such as the string? used in this example.


  Using the null-coalescing operator


  The null-coalescing operator is two question mark characters (??) and is used to provide a fallback value, often used in conjunction with the null conditional operator, as shown in listing 5.18.


  Listing 5.18 Using the null-coalescing operator in the HomeController.cs file in the Controllers folder

  namespace LanguageFeatures.Controllers {
    public class HomeController : Controller {
        
        public ViewResult Index() {
            Product?[] products = Product.GetProducts();
            return View(new string[] { products[0]?.Name ?? "No Value" });
        }
    }
}


  The ?? operator returns the value of its left-hand operand if it isn’t null. If the left-hand operand is null, then the ?? operator returns the value of its right-hand operand. This behavior works well with the null conditional operator. If products[0] is null, then the ? operator will return null, and the ?? operator will return "No Value". If products[0] isn’t null, then the result will be the value of its Name property. This is a more concise way of performing the same null checks shown in earlier examples.


  Note The ? and ?? operators cannot always be used, and you will see examples in later chapters where I use an if statement to check for null values. One common example is when using the await/async keywords, which are described later in this chapter, and which do not integrate well with the null conditional operator.


  5.4.5 Overriding null state analysis


  The C# compiler has a sophisticated understanding of when a variable can be null, but it doesn’t always get it right, and there are times when you have a better understanding of whether a null value can arise than the compiler. In these situations, the null-forgiving operator can be used to tell the compiler that a variable isn’t null, regardless of what the null state analysis suggests, as shown in listing 5.19.


  Listing 5.19 Using the null-forgiving operator in the HomeController.cs file in the Controllers folder

  namespace LanguageFeatures.Controllers {
    public class HomeController : Controller {
        
        public ViewResult Index() {
            Product?[] products = Product.GetProducts();
            return View(new string[] { products[0]!.Name });
        }
    }
}


  The null-forgiving operator is an exclamation mark and is used in this example to tell the compiler that products[0] isn’t null, even though null state analysis has identified that it might be.


  When using the ! operator, you are telling the compiler that you have better insight into whether a variable can be null, and, naturally, this should be done only when you are entirely confident that you are right.


  5.4.6 Disabling null state analysis warnings


  An alternative to the null-forgiving operator is to disable null state analysis warnings for a particular section of code or a complete code file, as shown in listing 5.20.


  Listing 5.20 Disabling warnings in the HomeController.cs file in the Controllers folder

  namespace LanguageFeatures.Controllers {
    public class HomeController : Controller {
        
        public ViewResult Index() {
            Product?[] products = Product.GetProducts();
            #pragma warning disable CS8602
            return View(new string[] { products[0].Name });
        }
    }
}


  This listing uses a #pragma directive to suppress warning CS8602 (you can identify warnings in the output from the build process).


  Note .NET includes a set of advanced attributes that can be used to provide the compiler with guidance for null state analysis. These are not widely used and are encountered only in chapter 36 of this book because they are used by one part of the ASP.NET Core API. See https://docs.microsoft.com/en-us/dotnet/csharp/language-reference/attributes/nullable-analysis for details.


  5.5 Using string interpolation


  C# supports string interpolation to create formatted strings, which uses templates with variable names that are resolved and inserted into the output, as shown in listing 5.21.


  Listing 5.21 Using string interpolation in the HomeController.cs file in the Controllers folder

  namespace LanguageFeatures.Controllers {
    public class HomeController : Controller {
        
        public ViewResult Index() {
            Product?[] products = Product.GetProducts();
                        
            return View(new string[] { 
                $"Name: {products[0]?.Name}, Price: { products[0]?.Price }"
            });
        }
    }
}


  Interpolated strings are prefixed with the $ character and contain holes, which are references to values contained within the { and } characters. When the string is evaluated, the holes are filled in with the current values of the variables or constants that are specified.


  Tip String interpolation supports the string format specifiers, which can be applied within holes, so $"Price: {price:C2}" would format the price value as a currency value with two decimal digits, for example.


  Start ASP.NET Core and request http://localhost:5000, and you will see a formatted string:

  Name: Kayak, Price: 275


  5.6 Using object and collection initializers


  When I create an object in the static GetProducts method of the Product class, I use an object initializer, which allows me to create an object and specify its property values in a single step, like this:

  ...
Product kayak = new Product {
    Name = "Kayak", Price = 275M
};
...


  This is another syntactic sugar feature that makes C# easier to use. Without this feature, I would have to call the Product constructor and then use the newly created object to set each of the properties, like this:

  ...
Product kayak = new Product();
kayak.Name = "Kayak";
kayak.Price = 275M;
...


  A related feature is the collection initializer, which allows the creation of a collection and its contents to be specified in a single step. Without an initializer, creating a string array, for example, requires the size of the array and the array elements to be specified separately, as shown in listing 5.22.


  Listing 5.22 Initializing an object in the HomeController.cs file in the Controllers folder

  namespace LanguageFeatures.Controllers {

    public class HomeController : Controller {
        
        public ViewResult Index() {
            string[] names = new string[3];
            names[0] = "Bob";
            names[1] = "Joe";
            names[2] = "Alice";
            return View("Index", names);
        }
    }
}


  Using a collection initializer allows the contents of the array to be specified as part of the construction, which implicitly provides the compiler with the size of the array, as shown in listing 5.23.


  Listing 5.23 A collection initializer in the HomeController.cs file in the Controllers folder

  namespace LanguageFeatures.Controllers {

    public class HomeController : Controller {
        
        public ViewResult Index() {
            return View("Index", new string[] { "Bob", "Joe", "Alice" });
        }
    }
}


  The array elements are specified between the { and } characters, which allows for a more concise definition of the collection and makes it possible to define a collection inline within a method call. The code in listing 5.23 has the same effect as the code in listing 5.22. Restart ASP.NET Core and request http://localhost:5000, and you will see the following output in the browser window:

  Bob
Joe
Alice


  5.6.1 Using an index initializer


  Recent versions of C# tidy up the way collections that use indexes, such as dictionaries, are initialized. Listing 5.24 shows the Index action rewritten to define a collection using the traditional C# approach to initializing a dictionary.


  Listing 5.24 Initializing a dictionary in the HomeController.cs file in the Controllers folder

  namespace LanguageFeatures.Controllers {

    public class HomeController : Controller {
        
        public ViewResult Index() {
            Dictionary<string, Product> products 
                    = new Dictionary<string, Product> {
                { 
                    "Kayak", 
                    new Product { Name = "Kayak", Price = 275M } 
                },
                { 
                    "Lifejacket",  
                    new Product{ Name = "Lifejacket", Price = 48.95M } 
                }
            };
            return View("Index", products.Keys);
        }
    }
}


  The syntax for initializing this type of collection relies too much on the { and } characters, especially when the collection values are created using object initializers. The latest versions of C# support a more natural approach to initializing indexed collections that is consistent with the way that values are retrieved or modified once the collection has been initialized, as shown in listing 5.25.


  Listing 5.25 Using collection initializer syntax in the HomeController.cs file in the Controllers folder

  namespace LanguageFeatures.Controllers {

    public class HomeController : Controller {
        
        public ViewResult Index() {
            Dictionary<string, Product> products 
                    = new Dictionary<string, Product> {
                ["Kayak"] = new Product { Name = "Kayak", Price = 275M },
                ["Lifejacket"] = new Product { Name = "Lifejacket", 
                    Price = 48.95M }
            };
            return View("Index", products.Keys);
        }
    }
}


  The effect is the same—to create a dictionary whose keys are Kayak and Lifejacket and whose values are Product objects—but the elements are created using the index notation that is used for other collection operations. Restart ASP.NET Core and request http://localhost:5000, and you will see the following results in the browser:

  Kayak
Lifejacket


  5.7 Using target-typed new expressions


  The example in listing 5.25 is still verbose and declares the collection type when defining the variable and creating an instance with the new keyword:

  ...
Dictionary<string, Product> products = new Dictionary<string, Product> {
    ["Kayak"] = new Product { Name = "Kayak", Price = 275M },
    ["Lifejacket"] = new Product { Name = "Lifejacket", Price = 48.95M }
};
...


  This can be simplified using a target-typed new expression, as shown in listing 5.26.


  Listing 5.26 Using a target-typed new expression in the HomeController.cs file in the Controllers folder

  namespace LanguageFeatures.Controllers {

    public class HomeController : Controller {
        
        public ViewResult Index() {
            Dictionary<string, Product> products = new () {
                ["Kayak"] = new Product { Name = "Kayak", Price = 275M },
                ["Lifejacket"] = new Product { Name = "Lifejacket", 
                    Price = 48.95M }
            };
            return View("Index", products.Keys);
        }
    }
}


  The type can be replaced with new() when the compiler can determine which type is required and constructor arguments are provided as arguments to the new method. Creating instances with the new() expression works only when the compiler can determine which type is required. Restart ASP.NET Core and request http://localhost:5000, and you will see the following results in the browser:

  Kayak
Lifejacket


  5.8 Pattern Matching


  One of the most useful recent additions to C# is support for pattern matching, which can be used to test that an object is of a specific type or has specific characteristics. This is another form of syntactic sugar, and it can dramatically simplify complex blocks of conditional statements. The is keyword is used to perform a type test, as demonstrated in listing 5.27.


  Listing 5.27 Testing a type in the HomeController.cs file in the Controllers folder

  namespace LanguageFeatures.Controllers {

    public class HomeController : Controller {
        
        public ViewResult Index() {
                
            object[] data = new object[] { 275M, 29.95M,
                "apple", "orange", 100, 10 };
            decimal total = 0;
            for (int i = 0; i < data.Length; i++) {
                if (data[i] is decimal d) {
                    total += d;
                }
            }
                        
            return View("Index", new string[] { $"Total: {total:C2}" });
        }
    }
}


  The is keyword performs a type check and, if a value is of the specified type, will assign the value to a new variable, like this:

  ...
if (data[i] is decimal d) {
...


  This expression evaluates as true if the value stored in data[i] is a decimal. The value of data[i] will be assigned to the variable d, which allows it to be used in subsequent statements without needing to perform any type conversions. The is keyword will match only the specified type, which means that only two of the values in the data array will be processed (the other items in the array are string and int values). If you run the application, you will see the following output in the browser window:

  Total: $304.95


  5.8.1 Pattern matching in switch statements


  Pattern matching can also be used in switch statements, which support the when keyword for restricting when a value is matched by a case statement, as shown in listing 5.28.


  Listing 5.28 Pattern matching in the HomeController.cs file in the Controllers folder

  namespace LanguageFeatures.Controllers {

    public class HomeController : Controller {
        
        public ViewResult Index() {
                
            object[] data = new object[] { 275M, 29.95M,
                "apple", "orange", 100, 10 };
            decimal total = 0;
            for (int i = 0; i < data.Length; i++) {
                switch (data[i]) {
                    case decimal decimalValue:
                        total += decimalValue;
                        break;
                    case int intValue when intValue > 50:
                        total += intValue;
                        break;
                }
            }
                        
            return View("Index", new string[] { $"Total: {total:C2}" });
        }
    }
}


  To match any value of a specific type, use the type and variable name in the case statement, like this:

  ...
case decimal decimalValue:
...


  This case statement matches any decimal value and assigns it to a new variable called decimalValue. To be more selective, the when keyword can be included, like this:

  ...
case int intValue when intValue > 50:
...


  This case statement matches int values and assigns them to a variable called intValue, but only when the value is greater than 50. Restart ASP.NET Core and request http://localhost:5000, and you will see the following output in the browser window:

  Total: $404.95


  5.9 Using extension methods


  Extension methods are a convenient way of adding methods to classes that you cannot modify directly, typically because they are provided by Microsoft or a third-party package. Listing 5.29 shows the definition of the ShoppingCart class, which I added to the Models folder in a class file called ShoppingCart.cs and which represents a collection of Product objects.


  Listing 5.29 The contents of the ShoppingCart.cs file in the Models folder

  namespace LanguageFeatures.Models {

    public class ShoppingCart {
        public IEnumerable<Product?>? Products { get; set; }
    }
}


  This is a simple class that acts as a wrapper around a sequence of Product objects (I only need a basic class for this example). Note the type of the Products property, which denotes a nullable enumerable of nullable Products, meaning that the Products property may be null and that any sequence of elements assigned to the property may contain null values.


  Suppose I need to be able to determine the total value of the Product objects in the ShoppingCart class, but I cannot modify the class because it comes from a third party, and I do not have the source code. I can use an extension method to add the functionality I need.


  Add a class file named MyExtensionMethods.cs in the Models folder and use it to define the class shown in listing 5.30.


  Listing 5.30 The contents of the MyExtensionMethods.cs file in the Models folder

  namespace LanguageFeatures.Models {

    public static class MyExtensionMethods {
        
        public static decimal TotalPrices(this ShoppingCart cartParam) {
            decimal total = 0;
            if (cartParam.Products != null) {
                foreach (Product? prod in cartParam.Products) {
                    total += prod?.Price ?? 0;
                }
            }
            return total;
        }
    }
}


  Extension methods are static and are defined in static classes. Listing 5.30 defines a single extension method named TotalPrices. The this keyword in front of the first parameter marks TotalPrices as an extension method. The first parameter tells .NET which class the extension method can be applied to—ShoppingCart in this case. I can refer to the instance of the ShoppingCart that the extension method has been applied to by using the cartParam parameter. This extension method enumerates the Product objects in the ShoppingCart and returns the sum of the Product.Price property values. Listing 5.31 shows how I apply the extension method in the Home controller’s action method.


  Note Extension methods do not let you break through the access rules that classes define for methods, fields, and properties. You can extend the functionality of a class by using an extension method but only using the class members that you had access to anyway.


  Listing 5.31 Applying an extension method in the HomeController.cs file in the Controllers folder

  namespace LanguageFeatures.Controllers {
    public class HomeController : Controller {
        
        public ViewResult Index() {
            ShoppingCart cart 
                = new ShoppingCart { Products = Product.GetProducts()};
            decimal cartTotal = cart.TotalPrices();
            return View("Index", 
                new string[] { $"Total: {cartTotal:C2}" });
        }
    }
}
The key statement is this one:
...
decimal cartTotal = cart.TotalPrices();
...


  I call the TotalPrices method on a ShoppingCart object as though it were part of the ShoppingCart class, even though it is an extension method defined by a different class altogether. .NET will find extension classes if they are in the scope of the current class, meaning that they are part of the same namespace or in a namespace that is the subject of a using statement. Restart ASP.NET Core and request http://localhost:5000, which will produce the following output in the browser window:

  Total: $323.95


  5.9.1 Applying extension methods to an interface


  Extension methods can also be applied to an interface, which allows me to call the extension method on all the classes that implement the interface. Listing 5.32 shows the ShoppingCart class updated to implement the IEnumerable<Product> interface.


  Listing 5.32 Implementing an interface in the ShoppingCart.cs file in the Models folder

  using System.Collections;

namespace LanguageFeatures.Models {

    public class ShoppingCart : IEnumerable<Product?> {
        public IEnumerable<Product?>? Products { get; set; }
                
        public IEnumerator<Product?> GetEnumerator() => 
                Products?.GetEnumerator()
                    ?? Enumerable.Empty<Product?>().GetEnumerator();
        IEnumerator IEnumerable.GetEnumerator() => GetEnumerator();
    }
}


  I can now update the extension method so that it deals with IEnumerable<Product?>, as shown in listing 5.33.


  Listing 5.33 Updating an extension method in the MyExtensionMethods.cs file in the Models folder

  namespace LanguageFeatures.Models {

    public static class MyExtensionMethods {
        
        public static decimal TotalPrices(
                this IEnumerable<Product?> products) {
            decimal total = 0;
            foreach (Product? prod in products) {
                total += prod?.Price ?? 0;
            }
            return total;
        }
    }
}


  The first parameter type has changed to IEnumerable<Product?>, which means the foreach loop in the method body works directly on Product? objects. The change to using the interface means that I can calculate the total value of the Product objects enumerated by any IEnumerable<Product?>, which includes instances of ShoppingCart but also arrays of Product objects, as shown in listing 5.34.


  Listing 5.34 Applying an extension method in the HomeController.cs file in the Controllers folder

  namespace LanguageFeatures.Controllers {
    public class HomeController : Controller {
        
        public ViewResult Index() {
            ShoppingCart cart 
                = new ShoppingCart { Products = Product.GetProducts()};
                                
            Product[] productArray = {
                new Product {Name = "Kayak", Price = 275M},
                new Product {Name = "Lifejacket", Price = 48.95M}
            };
                        
            decimal cartTotal = cart.TotalPrices();
            decimal arrayTotal = productArray.TotalPrices();
                        
            return View("Index", new string[] {
                $"Cart Total: {cartTotal:C2}",
                $"Array Total: {arrayTotal:C2}" });
        }
    }
}


  Restart ASP.NET Core and request http://localhost:5000, which will produce the following output in the browser, demonstrating that I get the same result from the extension method, irrespective of how the Product objects are collected:

  Cart Total: $323.95
Array Total: $323.95 


  5.9.2 Creating filtering extension methods


  The last thing I want to show you about extension methods is that they can be used to filter collections of objects. An extension method that operates on an IEnumerable<T> and that also returns an IEnumerable<T> can use the yield keyword to apply selection criteria to items in the source data to produce a reduced set of results. Listing 5.35 demonstrates such a method, which I have added to the MyExtensionMethods class.


  Listing 5.35 A filtering extension method in the MyExtensionMethods.cs file in the Models folder

  namespace LanguageFeatures.Models {

    public static class MyExtensionMethods {
        
        public static decimal TotalPrices(
                this IEnumerable<Product?> products) {
            decimal total = 0;
            foreach (Product? prod in products) {
                total += prod?.Price ?? 0;
            }
            return total;
        }
                
        public static IEnumerable<Product?> FilterByPrice(
                this IEnumerable<Product?> productEnum, 
                decimal minimumPrice) {
            foreach (Product? prod in productEnum) {
                if ((prod?.Price ?? 0) >= minimumPrice) {
                    yield return prod;
                }
            }
        }
    }
}


  This extension method, called FilterByPrice, takes an additional parameter that allows me to filter products so that Product objects whose Price property matches or exceeds the parameter are returned in the result. Listing 5.36 shows this method being used.


  Listing 5.36 Using the filtering extension method in the HomeController.cs file in the Controllers folder

  namespace LanguageFeatures.Controllers {
    public class HomeController : Controller {
        
        public ViewResult Index() {
            ShoppingCart cart 
                = new ShoppingCart { Products = Product.GetProducts()};
                                
            Product[] productArray = {
                new Product {Name = "Kayak", Price = 275M},
                new Product {Name = "Lifejacket", Price = 48.95M},
                new Product {Name = "Soccer ball", Price = 19.50M},
                new Product {Name = "Corner flag", Price = 34.95M}
            };
                        
            decimal arrayTotal = 
                productArray.FilterByPrice(20).TotalPrices();
                                
            return View("Index", 
                new string[] { $"Array Total: {arrayTotal:C2}" });
        }
    }
}


  When I call the FilterByPrice method on the array of Product objects, only those that cost more than $20 are received by the TotalPrices method and used to calculate the total. If you run the application, you will see the following output in the browser window:

  Total: $358.90


  5.10 Using lambda expressions


  Lambda expressions are a feature that causes a lot of confusion, not least because the feature they simplify is also confusing. To understand the problem that is being solved, consider the FilterByPrice extension method that I defined in the previous section. This method is written so that it can filter Product objects by price, which means I must create a second method if I want to filter by name, as shown in listing 5.37.


  Listing 5.37 Adding a filter method in the MyExtensionMethods.cs file in the Models folder

  namespace LanguageFeatures.Models {

    public static class MyExtensionMethods {
        
        public static decimal TotalPrices(
                this IEnumerable<Product?> products) {
            decimal total = 0;
            foreach (Product? prod in products) {
                total += prod?.Price ?? 0;
            }
            return total;
        }
                
        public static IEnumerable<Product?> FilterByPrice(
                this IEnumerable<Product?> productEnum, 
                decimal minimumPrice) {
            foreach (Product? prod in productEnum) {
                if ((prod?.Price ?? 0) >= minimumPrice) {
                    yield return prod;
                }
            }
        }
                
        public static IEnumerable<Product?> FilterByName(
                this IEnumerable<Product?> productEnum, 
                char firstLetter) {
                                
            foreach (Product? prod in productEnum) {
                if (prod?.Name?[0] == firstLetter) {
                    yield return prod;
                }
            }
        }
    }
}


  Listing 5.38 shows the use of both filter methods applied in the controller to create two different totals.


  Listing 5.38 Using two filter methods in the HomeController.cs file in the Controllers folder

  namespace LanguageFeatures.Controllers {
    public class HomeController : Controller {
        
        public ViewResult Index() {
            ShoppingCart cart 
                = new ShoppingCart { Products = Product.GetProducts()};
                                
            Product[] productArray = {
                new Product {Name = "Kayak", Price = 275M},
                new Product {Name = "Lifejacket", Price = 48.95M},
                new Product {Name = "Soccer ball", Price = 19.50M},
                new Product {Name = "Corner flag", Price = 34.95M}
            };
                        
            decimal priceFilterTotal = 
                productArray.FilterByPrice(20).TotalPrices();
            decimal nameFilterTotal = 
                productArray.FilterByName('S').TotalPrices();
                                
            return View("Index", new string[] {
                $"Price Total: {priceFilterTotal:C2}",
                $"Name Total: {nameFilterTotal:C2}" });
        }
    }
}


  The first filter selects all the products with a price of $20 or more, and the second filter selects products whose name starts with the letter S. You will see the following output in the browser window if you run the example application:

  Price Total: $358.90
Name Total: $19.50


  5.10.1 Defining functions


  I can repeat this process indefinitely to create filter methods for every property and every combination of properties that I am interested in. A more elegant approach is to separate the code that processes the enumeration from the selection criteria. C# makes this easy by allowing functions to be passed around as objects. Listing 5.39 shows a single extension method that filters an enumeration of Product objects but that delegates the decision about which ones are included in the results to a separate function.


  Listing 5.39 Creating a general filter method in the MyExtensionMethods.cs file in the Models folder

  namespace LanguageFeatures.Models {

    public static class MyExtensionMethods {
        
        public static decimal TotalPrices(
                this IEnumerable<Product?> products) {
            decimal total = 0;
            foreach (Product? prod in products) {
                total += prod?.Price ?? 0;
            }
            return total;
        }
                
        public static IEnumerable<Product?> FilterByPrice(
                this IEnumerable<Product?> productEnum, 
                decimal minimumPrice) {
            foreach (Product? prod in productEnum) {
                if ((prod?.Price ?? 0) >= minimumPrice) {
                    yield return prod;
                }
            }
        }
                
        public static IEnumerable<Product?> Filter(
                this IEnumerable<Product?> productEnum,
                Func<Product?, bool> selector) {
                                
            foreach (Product? prod in productEnum) {
                if (selector(prod)) {
                    yield return prod;
                }
            }
        }
    }
}


  The second argument to the Filter method is a function that accepts a Product? object and that returns a bool value. The Filter method calls the function for each Product? object and includes it in the result if the function returns true. To use the Filter method, I can specify a method or create a stand-alone function, as shown in listing 5.40.


  Listing 5.40 Using a function to filter objects in the HomeController.cs file in the Controllers folder

  namespace LanguageFeatures.Controllers {
    public class HomeController : Controller {
        
        bool FilterByPrice(Product? p) {
            return (p?.Price ?? 0) >= 20;
        }
                
        public ViewResult Index() {
            ShoppingCart cart 
                = new ShoppingCart { Products = Product.GetProducts()};
                                
            Product[] productArray = {
                new Product {Name = "Kayak", Price = 275M},
                new Product {Name = "Lifejacket", Price = 48.95M},
                new Product {Name = "Soccer ball", Price = 19.50M},
                new Product {Name = "Corner flag", Price = 34.95M}
            };
                        
            Func<Product?, bool> nameFilter = delegate (Product? prod) {
                return prod?.Name?[0] == 'S';
            };
                        
            decimal priceFilterTotal = productArray
                .Filter(FilterByPrice)
                .TotalPrices();
            decimal nameFilterTotal = productArray
                .Filter(nameFilter)
                .TotalPrices();
                                
            return View("Index", new string[] {
                $"Price Total: {priceFilterTotal:C2}",
                $"Name Total: {nameFilterTotal:C2}" });
        }
    }
}


  Neither approach is ideal. Defining methods like FilterByPrice clutters up a class definition. Creating a Func<Product?, bool> object avoids this problem but uses an awkward syntax that is hard to read and hard to maintain. It is this issue that lambda expressions address by allowing functions to be defined in a more elegant and expressive way, as shown in listing 5.41.


  Listing 5.41 Using a lambda expression in the HomeController.cs file in the Controllers folder

  namespace LanguageFeatures.Controllers {
    public class HomeController : Controller {
        
        //bool FilterByPrice(Product? p) {
        //    return (p?.Price ?? 0) >= 20;
        //}
                
        public ViewResult Index() {
            ShoppingCart cart 
                = new ShoppingCart { Products = Product.GetProducts()};
                                
            Product[] productArray = {
                new Product {Name = "Kayak", Price = 275M},
                new Product {Name = "Lifejacket", Price = 48.95M},
                new Product {Name = "Soccer ball", Price = 19.50M},
                new Product {Name = "Corner flag", Price = 34.95M}
            };
                        
            //Func<Product?, bool> nameFilter = delegate (Product? prod) {
            //    return prod?.Name?[0] == 'S';
            //};
                        
            decimal priceFilterTotal = productArray
                .Filter(p => (p?.Price ?? 0) >= 20)
                .TotalPrices();
                                
            decimal nameFilterTotal = productArray
                .Filter(p => p?.Name?[0] == 'S')
                .TotalPrices();
                                
            return View("Index", new string[] {
                $"Price Total: {priceFilterTotal:C2}",
                $"Name Total: {nameFilterTotal:C2}" });
        }
    }
}


  The lambda expressions are shown in bold. The parameters are expressed without specifying a type, which will be inferred automatically. The => characters are read aloud as “goes to” and link the parameter to the result of the lambda expression. In my examples, a Product? parameter called p goes to a bool result, which will be true if the Price property is equal or greater than 20 in the first expression or if the Name property starts with S in the second expression. This code works in the same way as the separate method and the function delegate but is more concise and is—for most people—easier to read.


  
    Other Forms for Lambda Expressions


    I don’t need to express the logic of my delegate in the lambda expression. I can as easily call a method, like this:

    ...
prod => EvaluateProduct(prod)
...


    If I need a lambda expression for a delegate that has multiple parameters, I must wrap the parameters in parentheses, like this:

    ...
(prod, count) => prod.Price > 20 && count > 0
...


    Finally, if I need logic in the lambda expression that requires more than one statement, I can do so by using braces ({}) and finishing with a return statement, like this:

    ...
(prod, count) => {
    // ...multiple code statements...
    return result;
}
...


    You do not need to use lambda expressions in your code, but they are a neat way of expressing complex functions simply and in a manner that is readable and clear. I like them a lot, and you will see them used throughout this book.

  


  5.10.2 Using lambda expression methods and properties


  Lambda expressions can be used to implement constructors, methods, and properties. In ASP.NET Core development, you will often end up with methods that contain a single statement that selects the data to display and the view to render. In listing 5.42, I have rewritten the Index action method so that it follows this common pattern.


  Listing 5.42 Creating a common action pattern in the HomeController.cs file in the Controllers folder

  namespace LanguageFeatures.Controllers {
    public class HomeController : Controller {
        
        public ViewResult Index() {
            return View(Product.GetProducts().Select(p => p?.Name));
        }
    }
}


  The action method gets a collection of Product objects from the static Product.GetProducts method and uses LINQ to project the values of the Name properties, which are then used as the view model for the default view. If you run the application, you will see the following output displayed in the browser window:

  Kayak


  There will be empty list items in the browser window as well because the GetProducts method includes a null reference in its results and one of the Product objects is created without a Name value, but that doesn’t matter for this section of the chapter.


  When a constructor or method body consists of a single statement, it can be rewritten as a lambda expression, as shown in listing 5.43.


  Listing 5.43 A lambda action method in the HomeController.cs file in the Controllers folder

  namespace LanguageFeatures.Controllers {
    public class HomeController : Controller {
        
        public ViewResult Index() => 
            View(Product.GetProducts().Select(p => p?.Name));
    }
}


  Lambda expressions for methods omit the return keyword and use => (goes to) to associate the method signature (including its arguments) with its implementation. The Index method shown in listing 5.43 works in the same way as the one shown in listing 5.42 but is expressed more concisely. The same basic approach can also be used to define properties. Listing 5.44 shows the addition of a property that uses a lambda expression to the Product class.


  Listing 5.44 A lambda property in the Product.cs file in the Models folder

  namespace LanguageFeatures.Models {
    public class Product {
        
        public string Name { get; set; } = string.Empty;
        public decimal? Price { get; set; }
                
        public bool NameBeginsWithS =>  Name.Length > 0 && Name[0] == 'S';
                
        public static Product?[] GetProducts() {
            Product kayak = new Product {
                Name = "Kayak", Price = 275M
            };
                        
            Product lifejacket = new Product {
                //Name = "Lifejacket", 
                Price = 48.95M
            };
                        
            return new Product?[] { kayak, lifejacket, null };
        }
    }
}


  5.11 Using type inference and anonymous types


  The var keyword allows you to define a local variable without explicitly specifying the variable type, as demonstrated by listing 5.45. This is called type inference, or implicit typing.


  Listing 5.45 Using type inference in the HomeController.cs file in the Controllers folder

  namespace LanguageFeatures.Controllers {
    public class HomeController : Controller {
        
        public ViewResult Index() {
            var names = new[] { "Kayak", "Lifejacket", "Soccer ball" };
            return View(names);
        }
    }
}


  It is not that the names variable does not have a type; instead, I am asking the compiler to infer the type from the code. The compiler examines the array declaration and works out that it is a string array. Running the example produces the following output:

  Kayak
Lifejacket
Soccer ball


  5.11.1 Using anonymous types


  By combining object initializers and type inference, I can create simple view model objects that are useful for transferring data between a controller and a view without having to define a class or struct, as shown in listing 5.46.


  Listing 5.46 An anonymous type in the HomeController.cs file in the Controllers folder

  namespace LanguageFeatures.Controllers {
    public class HomeController : Controller {
        public ViewResult Index() {
                
            var products = new[] {
                new { Name = "Kayak", Price = 275M },
                new { Name = "Lifejacket", Price = 48.95M },
                new { Name = "Soccer ball", Price = 19.50M },
                new { Name = "Corner flag", Price = 34.95M }
            };
                        
            return View(products.Select(p => p.Name));
        }
    }
}


  Each of the objects in the products array is an anonymously typed object. This does not mean that it is dynamic in the sense that JavaScript variables are dynamic. It just means that the type definition will be created automatically by the compiler. Strong typing is still enforced. You can get and set only the properties that have been defined in the initializer, for example. Restart ASP.NET Core and request http://localhost:5000, and you will see the following output in the browser window:

  Kayak
Lifejacket
Soccer ball
Corner flag


  The C# compiler generates the class based on the name and type of the parameters in the initializer. Two anonymously typed objects that have the same property names and types defined in the same order will be assigned to the same automatically generated class. This means that all the objects in the products array will have the same type because they define the same properties.


  Tip I have to use the var keyword to define the array of anonymously typed objects because the type isn’t created until the code is compiled, so I don’t know the name of the type to use. The elements in an array of anonymously typed objects must all define the same properties; otherwise, the compiler can’t work out what the array type should be.


  To demonstrate this, I have changed the output from the example in listing 5.47 so that it shows the type name rather than the value of the Name property.


  Listing 5.47 Displaying the type name in the HomeController.cs file in the Controllers folder

  namespace LanguageFeatures.Controllers {
    public class HomeController : Controller {
        
        public ViewResult Index() {
            var products = new[] {
                new { Name = "Kayak", Price = 275M },
                new { Name = "Lifejacket", Price = 48.95M },
                new { Name = "Soccer ball", Price = 19.50M },
                new { Name = "Corner flag", Price = 34.95M }
            };
                        
            return View(products.Select(p => p.GetType().Name));
        }
    }
}


  All the objects in the array have been assigned the same type, which you can see if you run the example. The type name isn’t user-friendly but isn’t intended to be used directly, and you may see a different name than the one shown in the following output:

  <>f__AnonymousType0`2
<>f__AnonymousType0`2
<>f__AnonymousType0`2
<>f__AnonymousType0`2


  5.12 Using default implementations in interfaces


  C# provides the ability to define default implementations for properties and methods defined by interfaces. This may seem like an odd feature because an interface is intended to be a description of features without specifying an implementation, but this addition to C# makes it possible to update interfaces without breaking the existing implementations of them.


  Add a class file named IProductSelection.cs to the Models folder and use it to define the interface shown in listing 5.48.


  Listing 5.48 The contents of the IProductSelection.cs file in the Models folder

  namespace LanguageFeatures.Models {

    public interface IProductSelection {
        
        IEnumerable<Product>? Products { get; }
    }
}


  Update the ShoppingCart class to implement the new interface, as shown in listing 5.49.


  Listing 5.49 Implementing an interface in the ShoppingCart.cs file in the Models folder

  namespace LanguageFeatures.Models {

    public class ShoppingCart : IProductSelection {
        private List<Product> products = new();
                
        public ShoppingCart(params Product[] prods) {
            products.AddRange(prods);
        }
                
        public IEnumerable<Product>? Products { get => products; }
    }
}


  Listing 5.50 updates the Home controller so that it uses the ShoppingCart class.


  Listing 5.50 Using an interface in the HomeController.cs file in the Controllers folder

  namespace LanguageFeatures.Controllers {
    public class HomeController : Controller {
        
        public ViewResult Index() {
            IProductSelection cart = new ShoppingCart(
                new Product { Name = "Kayak", Price = 275M },
                new Product { Name = "Lifejacket", Price = 48.95M },
                new Product { Name = "Soccer ball", Price = 19.50M },
                new Product { Name = "Corner flag", Price = 34.95M }
            );
            return View(cart.Products?.Select(p => p.Name));
        }
    }
}


  This is the familiar use of an interface, and if you restart ASP.NET Core and request http://localhost:5000, you will see the following output in the browser:

  Kayak
Lifejacket
Soccer ball
Corner flag


  If I want to add a new feature to the interface, I must locate and update all the classes that implement it, which can be difficult, especially if an interface is used by other development teams in their projects. This is where the default implementation feature can be used, allowing new features to be added to an interface, as shown in listing 5.51.


  Listing 5.51 Adding a feature in the IProductSelection.cs file in the Models folder

  namespace LanguageFeatures.Models {

    public interface IProductSelection {
        
        IEnumerable<Product>? Products { get; }
                
        IEnumerable<string>? Names => Products?.Select(p => p.Name);
    }
}


  The listing defines a Names property and provides a default implementation, which means that consumers of the IProductSelection interface can use the Names property even if it isn’t defined by implementation classes, as shown in listing 5.52.


  Listing 5.52 Using a default implementation in the HomeController.cs file in the Controllers folder

  namespace LanguageFeatures.Controllers {
    public class HomeController : Controller {
        
        public ViewResult Index() {
            IProductSelection cart = new ShoppingCart(
                new Product { Name = "Kayak", Price = 275M },
                new Product { Name = "Lifejacket", Price = 48.95M },
                new Product { Name = "Soccer ball", Price = 19.50M },
                new Product { Name = "Corner flag", Price = 34.95M }
            );
            return View(cart.Names);
        }
    }
}


  The ShoppingCart class has not been modified, but the Index method can use the default implementation of the Names property. Restart ASP.NET Core and request http://localhost:5000, and you will see the following output in the browser:

  Kayak
Lifejacket
Soccer ball
Corner flag


  5.13 Using asynchronous methods


  Asynchronous methods perform work in the background and notify you when they are complete, allowing your code to take care of other business while the background work is performed. Asynchronous methods are an important tool in removing bottlenecks from code and allow applications to take advantage of multiple processors and processor cores to perform work in parallel.


  In ASP.NET Core, asynchronous methods can be used to improve the overall performance of an application by allowing the server more flexibility in the way that requests are scheduled and executed. Two C# keywords—async and await—are used to perform work asynchronously.


  5.13.1 Working with tasks directly


  C# and .NET have excellent support for asynchronous methods, but the code has tended to be verbose, and developers who are not used to parallel programming often get bogged down by the unusual syntax. To create an example, add a class file called MyAsyncMethods.cs to the Models folder and add the code shown in listing 5.53.


  Listing 5.53 The contents of the MyAsyncMethods.cs file in the Models folder

  namespace LanguageFeatures.Models {

    public class MyAsyncMethods {
        
        public static Task<long?> GetPageLength() {
            HttpClient client = new HttpClient();
            var httpTask = client.GetAsync("http://manning.com");
            return httpTask.ContinueWith((Task<HttpResponseMessage> 
                    antecedent) => {
                return antecedent.Result.Content.Headers.ContentLength;
            });
        }
    }
}


  This method uses a System.Net.Http.HttpClient object to request the contents of the Manning home page and returns its length. .NET represents work that will be done asynchronously as a Task. Task objects are strongly typed based on the result that the background work produces. So, when I call the HttpClient.GetAsync method, what I get back is a Task<HttpResponseMessage>. This tells me that the request will be performed in the background and that the result of the request will be an HttpResponseMessage object.


  Tip When I use words like background, I am skipping over a lot of detail to make just the key points that are important to the world of ASP.NET Core. The .NET support for asynchronous methods and parallel programming is excellent, and I encourage you to learn more about it if you want to create truly high-performing applications that can take advantage of multicore and multiprocessor hardware. You will see how ASP.NET Core makes it easy to create asynchronous web applications throughout this book as I introduce different features.


  The part that most programmers get bogged down with is the continuation, which is the mechanism by which you specify what you want to happen when the task is complete. In the example, I have used the ContinueWith method to process the HttpResponseMessage object I get from the HttpClient.GetAsync method, which I do with a lambda expression that returns the value of a property that contains the length of the content I get from the Manning web server. Here is the continuation code:

  ...
return httpTask.ContinueWith((Task<HttpResponseMessage> antecedent) => {
    return antecedent.Result.Content.Headers.ContentLength;
});
...


  Notice that I use the return keyword twice. This is the part that causes confusion. The first use of the return keyword specifies that I am returning a Task<HttpResponseMessage> object, which, when the task is complete, will return the length of the ContentLength header. The ContentLength header returns a long? result (a nullable long value), and this means the result of my GetPageLength method is Task<long?>, like this:

OEBPS/OEBPS/Images/CH03_F04_Freeman.png
[ x
€ 5 C O balhossio

Your name:
Your email:
Your phone:

Will you attend? [Choose an option v
‘Submit RSVP |






OEBPS/OEBPS/Images/CH03_F03_Freeman.png
‘This is the RsvpForm.cshtml View






OEBPS/OEBPS/Images/CH03_F07_Freeman.png
I Raprom

€ 5 C O localhosts000Home/RsvpForm

* Please eater your email address
« Please enter your phone number
* Please specify whether you'l antend

Wil you aend”
[Smirsie |






OEBPS/OEBPS/Images/CH03_F08_Freeman.png
pr P g
P
Shenerco L) e L
e s Vcs
=
o B s Vowics
oner
A B sssneansn e
Conent
» onin
o I ——————

[Seuch ) 7=
e ouaice
Acrcatng s (€59 o ch
v i






OEBPS/OEBPS/Images/CH03_F01_Freeman.png
1 Py x

€ 5 C O locaostsoo

‘We're going to have an exciting party.
(To do: sell it better. Add pictures or something.)






OEBPS/OEBPS/Images/CH03_F09_Freeman.png
I Raprom

€ 5 C O localosts000Home/RsvpForm

* Please enter your emai address.
« Please enter your phone number
iy whether you'll atend






OEBPS/cover.jpeg
TENTH EDITION

Adam Freeman

/'l MANNING





OEBPS/OEBPS/Images/CH02_F07_Freeman.png
8 QU Server nstallation Center

Plnring.
Intalation
Maintennce
Took:

Microsoft SQL Server 2022

®

Launch a iz to ol QL Srver 2022 i non-cstered envionment rto 54
feturesto an eising SQL Sevr 202 nstance.

o

Launch adenioad page that povides ikt sl SO Senver RepertingSenices. A
intrne connecion  reuied 1o tall SSS.

102 0L Seve Mamagement Toos
Launch a downioad page hat provides ink o sl SO Senver Mansgement St
50U Sever command-ine ks (SQLCMD and CP) QL Seve Powershl providr,
SQL SevrPrfie nd Ostabase Tuning Adisor. An tenet connecion s equied o
nstal these ook

o (DT

Launch  denoad page that provides a ink o nstll S Server Dt Tos (SSDT). SSOT
provides Visul St tegation inchading prject system supportfor Micioslt Arre
501 Datibase the SQL SenverDatabaseEnin, Reporting Serices, Analyss Sevices and
Integtion Senice. An et omnecion s requred 1 mal S50,

_ "
Launch o wizad o upgrade s previous version of L Sever o SO Server 222
Clik hreto it view Upgrade Dosumentation






OEBPS/OEBPS/Images/CH02_F18_Freeman.png
€ 5 C O localostson

Hello World (from the view)






OEBPS/OEBPS/Images/CH02_F06_Freeman.png
SQL Server 2022
Express Edition
Select an installation type:

Basic Custom
St Cusom st e

-
o g S S

vt S SOt
Ergoe et i et

Download Media

Donriosd sl Sener s s






OEBPS/OEBPS/Images/CH02_F17_Freeman.png
4 Vimics
4 aspNETCore
Code
o
Genenst
4w
soner

Sarpts
Cortent

csnap
» onine

Sony [ttt

[Sevn G-

£

[ T

VG

R —

[ oo
[

7 —

e

Vi

VoG

Vs

Vi

Viunics.

Type: Viwice
RazorvenPage

aa ][ e






OEBPS/OEBPS/Images/Manning_M_small.png





OEBPS/OEBPS/Images/CH02_F04_Freeman.png
nstlaion ocatons

)

9 S0 e Commns o it

B ety
Code odls

Installtion detals
+ Visual Sucio core editor
- ASPNET and web development
[ e —
P ————
- o
[T prpa—

20 Aot ot st o Pt B RISl





OEBPS/OEBPS/Images/CH02_F15_Freeman.png
€ 5 C O locahostson

Hello World






OEBPS/OEBPS/Images/CH02_F05_Freeman.png
Q) Setup - Microsoft Visual Studio Code (User)

Select Addtonsi Tasks
i s tsks shoddbe psforned?

Selct the s ks o woud e S 0 perforn vl sl Vil S
=ty

ol cre:

O creste s desktonicn
ot

01O it o scion t Wrdons Exces e cantertmers
(0] A" i Codeacion t Widons Exoresdrecry cntext e

S

o ] [






OEBPS/OEBPS/Images/CH02_F14_Freeman.png
tome Page - Frsprject
€ 5 C O locahostson

FirstProject Home  Prvacy

Welcome

Leam about buiding Web apps with ASPNET Core.

©.2023 - FistProject - Prvacy.






OEBPS/OEBPS/Images/CH02_F16_Freeman.png
1 it S o x
€ > C O lowhostsno ) @

An unhandled exception occurred while processing the request.

InvalidOperationException: The view MyView' was not found. The following locations were searched:

Views/Home/MyView.cshtml
Niews/Shared/MyView.cshtml

Micosoft AspetCore MicVieaEngines ViewEngineResul Ensuresuccessful Enumerable<ting> orignallocatons)

ER Query Cookies Headers Routing

InvalidOperationException: The view "MyView' was not found. The following locations were

“earched: [Views/Home/MyViewcsha==I /Views/Shared/MyView.cshtml ..






OEBPS/OEBPS/Images/CH02_F03_Freeman.png
[k v
smSRE

f E——






OEBPS/OEBPS/Images/CH04_F06_Freeman.png
J o osanan - R

€ > C @ localhost5000/demohtml * ®

New Me






OEBPS/OEBPS/Images/CH02_F11_Freeman.png
©8|0-06 || £[=]

Sevch Slaton Explrer (Ct-) 2

R Solution FstProject (1 of 1 preec)

@ Comnected Snices
8 Oependencies

Q propetis

& wncor

© Convotes

5 Mades

5 Views

D sppstingson
D glvatson

5 ca progamer






OEBPS/OEBPS/Images/CH05_F03_Freeman.png
% LanguagereatuesContolsH

Sranespace LanguageFeatures. Cortrallers {
o public class HoseController : Controller {

public ViemResult Tndex() {
Product?[] products = Product.Getroducts();
return Vien(nen string(] { productsle] Nase 1);






OEBPS/OEBPS/Images/CH04_F07_Freeman.png
X Fe Edt Seecton View Go Run Teminal Help

© progames x
Mt > @ progames

var butlder « Webipplication.Crestedutlden(ares):
var 499 - bullder 8116003
v

Var bultder = Wb Tication CreatiBuTIaenC
Vaz 2pp = bullder.8uilé0;

> 0. HapGet/", () > “Hello vorler

app.usestaticrites0;

app.usestatictles);

09,0005

2
s appun0;





OEBPS/OEBPS/Images/CH02_F10_Freeman.png
Visual Studio 2022

Open ecent

Getsared
Syttt o e gt EEr——

= SIS
e e

(8 Opena projector solution

bkt p

=1 o ocioer

Ll






OEBPS/OEBPS/Images/CH02_F12_Freeman.png
X e it Sekcion View Go Run Temial Wep Fetbroet-VawiSudoCodelhdmnwa. — O X

stoRoecr
> bin

> controlers

> Models

> oty

> properies

> Views

> oot

1) appsetings e
00 appsetingsjson

Jopmentjson

Fistorcectin
0 gioblson

© Programes

> ourume






OEBPS/OEBPS/Images/CH02_F01_Freeman.png
Visual Studio Installer

Before you get tarted.we need o set up 3 few things so that you
can configure your instllation.

ol moreabout priacy, s he Microsot Py Ssement.
By contiuing you agee o the MicosotSofvareLense Terms.






OEBPS/OEBPS/Images/CH02_F13_Freeman.png
® Do youwant to sl h recommended exensons for 7 @ X

[\ Requird asetsto buid and dbug are missing from @ x
Fistrojct. Add them?

- [T





OEBPS/OEBPS/Images/CH05_F01_Freeman.png





OEBPS/OEBPS/Images/CH05_F02_Freeman.png
[ e

[ rasespace Languagereatures.odels ¢
|2 public ctass product ¢

public string lame { get; set; )

public static Product(] GetProducts() {
Product kayak = new Product {
Nase = "Wayakc, Price = 275
&
Product Uifejacket = new Product {

Name = "Lifeficket®, Price = 48.95H
i

return new Product(] { kayak, Uifejacket, null );
H






OEBPS/OEBPS/Images/CH02_F02_Freeman.png
Visual Studio Installer
Just a moment . Fetching your fles.

ouniosing: 111715047123 2o

sting






OEBPS/OEBPS/Images/CH03_F13_Freeman.png
I Responses

€ 5 C O localhosts000/Home/listResponses. % ®

Here is the list of people attending the party

Neme Email Phone
Joe joe@example.com 5551234
alice@examgle.com 5506789

dora@example.com 5551111






OEBPS/OEBPS/Images/CH03_F11_Freeman.png
Will you attend?

Choose an option






OEBPS/OEBPS/Images/CH03_F12_Freeman.png
[
<

5 © O loclosts000/Home/RsvpForm

Thank you, Jo

It great that youre coming. The drinks are already in the fridge!
Click hete to see who is coming.






OEBPS/OEBPS/Images/CH04_F05_Freeman.png
€ > C O localhosts000/demotmi

New Message






OEBPS/OEBPS/Images/CH03_F10_Freeman.png
€ 5 C O oihostson x ®

We're going to have an exciting party!

And YOU are invited!

PN






OEBPS/OEBPS/Images/CH01_F01_Freeman.png
Application Frameworks

Utility Frameworks.

mve Razor — a I M ety 1
Framework Pages | Y 1| Framework |
Platform
HTTP S T Dependency | [ configuration
Server Injection & Logging
Model .
Caching Binding Razor gRPC SignalR






OEBPS/OEBPS/Images/CH04_F03_Freeman.png
Seschsuien e ().
T Soen MySontion (1 f 1 s

N B78 AxBx
H
H
£
g






OEBPS/OEBPS/Images/CH04_F04_Freeman.png
€ 5 C O locaost5000/demontmi

HTML File from MyProject






OEBPS/OEBPS/Images/CH04_F02_Freeman.png
AddNewtem - Mybrcject
4 st

4 Vi
4 APNET Core
Code
o
Genent
v
asones
scips
Contet

» Onine

Nome. demonm

Vil e

Viuai 2

Viual s

Visice

Semch (Coto

Type: Viual e
A HTML page

code

aninclude clentde

aa || Conce






OEBPS/OEBPS/Images/CH02_F08_Freeman.png
T QU Server 2022 Seup 4

Feature Selection r
PR ST—— v
License Terms o ’
7 Dosnesti ot
P [ S——
S — g
ot St i e Fes
ot Diowusuebrginesevice
e Bt fo S S G150t semerReplction
i 3 Macin LesmingSnces and Langunge xtensions

5 il Txt andSemantic Extacions for Seach

Festure Rles I PolBase QueySence forEtems Ot Prereuihesor ey
Instance Confguation it
Sene Confgution ==
Databas Engine Configuation Tobentald g
Fesure Configuration Rles Micosot Vi
InsaltionPrgres:

Dk Space Resuie

Complete

N o BNy





OEBPS/OEBPS/Images/CH02_F19_Freeman.png
€ 5 € O locahostsoon Q% ®

Good Afternoon World (from the view)






OEBPS/OEBPS/Images/CH02_F09_Freeman.png
T QU Server 2022 Seup - @

Instance Configuration

Specitythe name and nstanceID for the nstance of SO Senver. Instonce 1D becomes part ofthe sl pth

e

ibel fuks 'O Nemedinstance:* | MSSQLSERVER
Moo U
s i
B Instance ID: [MSSQUSERVER
e ciontor S ever-
s Sicion
Sy s el S NS TSMSRLSERVER
Bl e P A nsom





OEBPS/OEBPS/Images/CH04_F01_Freeman.png
Stucio Code - o x

0@ o-08F| 4]

> aseade 5 SolutionMySoluton' (1o 1 prject
> bin ST
> ok @ ComectedSevices

> properties
S properies
@ sppretingsizon
D sppsetings Developmentson
@ glovason
b cn Pregames

v
b 26 Dependences

> oot ”

1) sppsetings Developmentjson ‘

) appsetingsjson

0 gibotzon

 wy
© programcs
Mysclionsi

sprcj





OEBPS/OEBPS/Images/fm_adam_freeman.png





OEBPS/OEBPS/Images/Manning_copyright.png





OEBPS/OEBPS/Images/CH03_F06_Freeman.png
1 Resporses

€ 5 C O localhost5000/Home/ListResponses *

Here is the list of people attending the party

Name  Email Phone.
Joe  joe@examplecom 3551234
Alice alice@example com 3556789






OEBPS/OEBPS/Images/CH03_F05_Freeman.png
1 oo P
R . @ ®
€ 5 C Oranosio

TR

Thank you, Joe!

165 great that you're coming. The drinks ar already in the fride
Cli






